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SpecificaŃiile problemei: 

1. Crearea geometriei în GAMBIT; 

2. Mesharea geometriei în GAMBIT; 

3. Specificarea tipurilor de limite în GAMBIT; 

4. Implementarea problemei în FLUENT; 

5. Rezolvarea; 

6. Analiza rezultatelor; 

7. CurăŃirea meshurilor; 

Problema 1 

Problema 2 

 

SpecificaŃiile problemei 

 

 

 

Se consideră un fluid care circulă printr-o conductă cu secŃiune constantă. Diametrul 

conductei este de 0,2 m şi are o lungime de 8 m. Viteza de intrare este de 1 m/s şi este 

constantă pe secŃiunea de intrare. Fluidul iese apoi în atmosfera care se află la presiunea de 1 

atm. Considerând densitatea ρ = 1 Kg/m3 şi coeficientul de viscozitate de µ = 2 x 10-3
 Kg/ms.  

Numărul lui Reynolds – Re – bazat pe diametrul conductei este: 

 Re = 
ρVavgD

µ  = 100 

Unde: Vavg – viteza medie la intrare, care este de 1 m/s în cazul nostru; 

 

RezolvaŃi această problemă folosind programul de simulare FLUENT. RezolvaŃi apoi 

graficul vitezei la centru, coeficientul de frecare la limita pereŃilor şi profilul vitezei la ieşire. 

ValidaŃi răspunsul. 

Notă: Valorile vitezei la intrare şi proprietăŃile fluxului sunt alese convenŃional. Se va 

axa mult pe numărul lui Reynolds. 

Vin 
L 

d = 0,2 
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Analiza preliminară 

Se preconizează ca vâscozitatea stratului limită să crească începând de la intrare. 

Eventual va creşte până va umple complet conducta (considerând conducta destul de lungă). 

Când acest lucru are loc, fluxul este complet dezvoltat, nemaiavând variaŃie a profilului de 

viteză de-a lungul direcŃiei axiale, x (vezi figura de mai jos). Se poate obŃine o soluŃie a 

ecuaŃiei în regiunea dezvoltată în totalitate. Lucru vizibil şi în cursul de „Introducere în 

Mecanica Fluidelor”. Vom compara rezultatele numerice obŃinute în zona dezvoltată 

complet cu cele obŃinute analitic. O recomandare este revederea cursului introductiv pentru 

analiza fluxului complet dezvoltat. Care sunt valorile vitezei în centru şi factorul de frecare 

pe care le avem în zona complet dezvoltată, bazându-ne pe soluŃiile analitice? Care este 

soluŃia pentru profilul de viteză? 

 

Vom crea geometria şi meshurile în GAMBIT (preprocesorul programului Fluent) şi apoi le 

vom citi şi rezolva în Fluent. 
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PASUL 1: CREAREA GEOMETRIEI ÎN GAMBIT. 

 

Dacă dorim să sărim peste acest pas, putem crea un folder de lucru (vezi mai jos) în care să 

descărcăm meshurile (clic dreapta şi salvaŃi ca „pipe.msh”) şi apoi trece direct la pasul 4. 

 

Strategii pentru crearea geometriei. 

Pentru a crea un dreptunghi, vom începe cu poziŃionarea a patru vertexuri (puncte) în cele 

patru colŃuri. Apoi vom uni punctele adiacente cu o linie dreaptă pentru a forma laturile 

(edges) dreptunghiului. În cele din urmă vom crea „faŃa” care corespunde suprafeŃei 

interioare a dreptunghiului. La pasul 2 vom face mesharea feŃei (dreptunghiului). Pentru 

problemele tridimensionale trebuie creat un volum (a treia dimensiune) format din feŃe. Mai 

scurt, etapele pentru crearea unui obiect tridimensional în Gambit sunt: Crearea punctelor – 

Crearea Laturilor - Crearea FeŃelor – Crearea Volumelor. 

 

Crearea unui folder de lucru 

CreaŃi un folder numit „pipe”. Vom folosi acest folder ca fiind folderul de lucru în care se 

vom păstra toate fişierele. 

 

Pornirea GAMBIT-ului 

Se iniŃializează prompterul de comenzi 

Start > Run 

 

Pentru Window NT/2000/XP: Se scrie cmd apoi se apasă OK 
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După aceasta, intraŃi în folderul de lucru. De exemplu, dacă folderul creat, numit fluent pe 

partiŃia S: în Windows, executaŃi cd S:\fluent  

 

 

InterfaŃa GAMBIT arată astfel: 

- Bara meniului principal: 

 

 

- Meniul instrumentelor 

 

Vom folosi acest meniu mai mult sau mai puŃin de-a lungul creării geometriilor. Se poate 

observa că fiecare meniu principal are sub-meniuri. 

 

- Meniul de control  
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Meniul de control are opŃiuni precum „Fit to Screen”  şi „Undo”  care sunt foarte 

des utilizate în timpul creării geometriei precum şi a meshurilor. 

 

- Fereastra de lucru: 

 

Aceasta este fereastra unde se pot observa grafic toate operaŃiile pe care le executăm. 

 

- Panoul de descriere 

 

Panoul de descriere conŃine descrierile butoanelor sau obiectelor peste care mişcăm cursorul 

mouseului. Mişcând mouseul peste butoate, putem observa aceste descrieri. 

 

- Fereastra de transcriere a comenzilor 

 

Aceasta este fereastra în care se scriu comenzile în Gambit şi în care se pot şterge/corecta. 

Dacă nu suntem siguri ca am apăsat butonul corect sau am greşit comanda, aici se poate 
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monitoriza. Se poate mări fereastra prin apăsarea săgeŃii din partea de sus, dreapta iar pentru 

a reveni la dimensiunile iniŃiale, se apasă din nou. 

 

Selectarea Solverului 

Main Menu > Solver > Fluent 5/6 

 

Se verifică apoi dacă s-a activat, în fereastra de transcriere a comenzilor. 

 

 

Putem presupune o curgere axisimetrică. Domeniul problemei este: 

0 
2

D
r ≤≤ , 0 ≤  x ≤  L 

Unde r şi x sunt coordonatele radiale, respectiv spaŃiale. 

 

Strategii pentru crearea geometriei 

Vom plasa originea sistemului de coordonate în colŃul de jos stânga a dreptunghiului. 

Coordonatele colŃurilor sunt arătate în figura de mai jos: 

 

Vom crea pentru început patru puncte în cele patru colŃuri ale dreptunghiului pe care le vom 

intersecta prin segmente, formând laturile. După aceasta, vom construi faŃa dreptunghiului 

care acoperă suprafaŃa interioară a lui. 

 

 

(8.0) 

(8,0.1) (0,0.1) 

(0,0) 



Laborator 1. Curgerea laminară în conducte 

 7 

ConstrucŃia punctelor (vertexurilor)  

Se construiesc din meniul instrumentelor urmând următorii paşi: 

Operation Toolpad > Geometry Command Button  > Vertex Command Button 

 > Create Vertex  

 

Următorul pas este introducerea coordonatelor. Vom începe prin crearea unui vertex în colŃul 

stânga jos a dreptunghiului: 

În dreptul lui x: vom introduce valoarea 0. În dreptul lui y: de asemenea 0 iar la z: tot 

valoarea 0 (din cauză că avem o problemă bidimensională). Apoi se face clic pe „Apply”. 

Aceste valori au creat vertexul care are coordonatele (0,0,0). În figura de mai jos se observă 

grafic aceste valori: 

 

În fereastra de transcriere a comenzilor, Gambit-ul ne afişează comanda de creare a 

vertexului „Created vertex: vertex.1”. Vertexurile sunt numerotate consecutiv: vertex.1, 

vertex.2 etc.; în ordinea în care au fost create. 

 

Repetăm apoi acest proces pentru a crea celelalte trei vertexuri: 

Vertexul 2: (0,0.1,0) 

Vertexul 3: (8,0.1,0) 

Vertexul 4: (8,0,0) 

 

Apoi, pentru a putea încadra toate puncte în ecran, vom folosi comanda „Fit to window”. 
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Operation Toolpad > Global Control > Fit to Window Button  

 

Acum putem observa pe ecran toate cele patru puncte. 

 

 

ConstrucŃia laturilor 

În continuare vom conecta perechi apropiate de vertexuri pentru a crea laturile:  

Operation Toolpad > Geometry Command Button  > Edge Command Button 

 > Create Edge  

 

Pentru selectarea unui obiect în Gambit, se Ńine buton SHIFT de la tastatură şi apoi se 

selectează. Se pot face astfel selecta mai multe obiecte. În cazul nostru, vom selecta, pe rând, 

vertexurile. Pe măsură ce selectăm vertexurile, pe ecran ele vor apărea de culoare roşie (pot 

apărea şi de altă culoare, în funcŃie de setările culorilor – standard este roşie). Făcând click pe 

săgeata în sus din meniu, o mică fereastră se va deschide. 

  

În această mini-fereastră vom observa vertexurile selectate. Ele pot fi mutate din stânga, unde 

sunt cele disponibile (Available) spre dreapta, unde sunt cele selectate (Picked) şi invers. 

Procesul de mutare se poate face simplu cu ajutorul săgeŃilor (---> şi <---). 
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După ce au fost selectate vertexurile corecte, se închide mini-fereastra făcând click pe 

butonul Close apoi Apply din meniul de creare a laturilor. 

Pe ecran va apărea următoarea imagine: 

 

Se repetă aceiaşi paşi pentru crearea celorlalte laturi. 

 

ConstrucŃia feŃelor 

Operation Toolpad > Geometry Command Button  > Face Command Button  

> Form Face  

Pentru a construi o faŃă înscrisă de patru laturi trebuie să selectăm cele patru laturi care 

formează suprafaŃa. Aceasta se poate face tot cu ajutorul tastei SHIFT, selectând pe rând 

fiecare latură (putem observa că liniile selectate apar de culoare roşie). După ce s-au selectat 

cele patru laturi, se ia mâna de pe tastă. 

Sau, mai simplu, se face clic pe săgeata în sus care deschide o alta mini-fereastră în care 

avem de această dată laturile. 

 

Iar mini-fereastra arată ca în figura de mai jos. 
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Se trec apoi toate din stânga în dreapta prin simplu clic pe All����. Se închide apoi mini-

fereastra făcând clic pe Close apoi Apply. 
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PASUL 2: GEOMETRIA MESHURILOR ÎN GAMBIT 

Vom mesha o faŃă a dreptunghiului cu 100 de diviziuni în direcŃia axial şi 5 în diviziuni în 

direcŃia radială. Pentru început vom mesha cele patru laturi apoi faŃa. SpaŃiul dintre grile este 

specificat de către meshul feŃei. 

 

Mesharea laturilor 

Operation Toolpad > Mesh Command Button  > Edge Command Button  > 

Mesh Edges  

Din nou selectăm cu ajutorul tastei SHIFT sau din meniu laturile verticale. Dacă în fereastra 

grafică nu se observă bine aceste linii, putem mări Ńinând apăsată tasta CTRL apoi click pe 

zona pe care vrem să o mărim. Dacă s-a mărit prea mult, se poate reveni folosind „Fit to 

Window”. 

După ce am selectat una dintre laturile verticale, o vom diviza folosind „Interval Count” din 

butonul pe care scrie „Interval Size” din cadrul meniului de meshare a laturilor. Apoi, în 

stânga se va trece numărul de diviziuni (în cazul nostru 5). 

 

Apoi se face clic pe Apply.  

Pe ecran va apărea imaginea ca în figura de mai jos: 
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Se repetă acelaşi algoritm şi pentru mesharea laturilor orizontale, dar divizat în 100 de unităŃi. 

După ce am meshuit laturile putem crea meshuirea bidimensională a feŃei. 

 

Mesharea feŃei 

Operation Toolpad > Mesh Command Button  > Face Command Button  > 

Mesh Face  

Se selectează apoi faŃa, cu ajutorul săgeŃii sau tastei SHIFT după care se face clic pe Apply 
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PASUL 3: SPECIFICAREA TIPURILOR DE LIMITĂ 

 

Definirea tipurilor de limită 

După cum se observă şi în figura de mai sus, vom definit tipurile de limite. Astfel, latura din 

stânga va fi intrarea în conductă, latura din dreapta ieşirea, cea de sus o definim ca fiind 

perete iar cea de jos ca axa. 

Operation Toopad > Zones Command Button  > Specify Boundary Types 

Command Button  

Aceasta va deschide meniul de specificare a tipurilor de limită. Prima dată vom specifică că 

latura din dreapta este intrarea. La „Entity:” vom face clic pe Edges pentru ca Gambitul să 

ştie că vrem să selectăm o latură. 

 

Vom selecta latura din stânga după care se face clic pe Apply. Apoi, la Name: vom pune 

inlet iar la Type: vom alege VELOCITY_INLET, urmat de Apply. 

Repetăm aceiaşi paşi şi pentru celelalte laturi, respectând tabelul: 

POZIłIA LATUREI NUMELE TIPUL 

Stânga inlet VELOCITY_INLET 

Dreapta outlet PRESSURE_OUTLET 

Sus wall  WALL 

Jos centerline  AXIS 

 

 

Axis (axa) 

Outlet 
(ieşire) 

Inlet 
(intrare) 

Wall (perete) 
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La final vom avea următoarele: 

 

 

Salvarea lucrului şi Exportul 

Main Menu > File > Save 

Main Menu > File > Export > Mesh 

Scriem pipe.msh la File Name:, apoi selectăm Export 2d Mesh deoarece este un mesh 

bidimensional. În final, clic Accept. 

 

Verificăm dacă pipe.msh a fost creat în folderul de lucru. 
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PASUL 4: SETAREA PROBLEMEI ÎN FLUENT 

Se deschide fluentul: 

Start > All Programs > Fluent Inc Products > Fluent x.x.xx > Fluent x.x.xx 

 

 

Selectăm 2ddp din listă apoi Run 

„2ddp” este folosit atunci când folosim un solver bidimensional, de precizie dublă. În 

solverul de precizie dublă fiecare număr este reprezentat folosind 64 biŃi, în contrast cu 

solverul de precizie simplă care foloseşte 32 biŃi. Numărul mare de biŃi creşte precizia dar şi 

ordinul de mărime care poate fi reprezentat. Dezavantajul este că pentru astfel de solver 

avem nevoie de mai multă memorie. 

 

Importul grilei 

Main Menu > File > Read > Case… 

Cazul se deschide din folderul de lucru de unde se selectează pipe.msh. Acest este fişierul 

care a fost creat de preprocesorul Gambit în pasul anterior. Fluentul expune meshurile exact 

cum sunt ele scrise în Gambit.  
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Verificăm numărul de noduri, feŃe (de diferite tipuri) şi celule. În cazul nostru avem 500 

celule patrulatere. Acesta este numărul la care era normal să ne aşteptăm din moment ce 

aveam 5 diviziuni în direcŃia radială şi 100 de diviziuni în direcŃia axială atunci când am 

construit grila, deci numărul total de celule este 5 · 100 = 500. 

De altfel, dacă privim la zone, avem inlet, wall, outlet  şi centerline. 

 

Verificarea şi afişarea grilei 

Pentru început se verifică grila pentru a fi siguri că nu sunt erori.  

a ) Verificarea grilei se face din 

Main Menu > Grid > Check  

Orice eroare întâlnită va fi reportată imediat. Verificăm apoi ieşirea pentru a fi siguri că nici 

acolo nu avem erori. Apoi se face verificarea dimensiunii grilei: 

Main Menu > Grid > Info > Size 

Aceasta arată ca în figura de mai jos: 

  

b) Afişarea grilei se face din: 

Main Menu > Display > Grid 

Trebuie să ne asigurăm că toate suprafeŃele (Surfaces) sunt selectate. Apoi facem clic pe 

Display. O nouă fereastră în care vom observa grila se va deschide. Se va închide apoi făcând 

click pe Close. 

OperaŃiile disponibile în fereastra de grid sunt: 

- TranslaŃia: Gridul poate fi mutat în orice direcŃie, Ńinând apăsat clic stanga şi 

mişcând mouseul; 

- Mărirea: Aceasta se poate face Ńinând apăsată rotiŃa mouseului după care se mişcă 

din stânga spre dreapta. 

- Micşorarea: Aceasta se poate face Ńinând apăsată rotiŃa mouseului după care se mişcă 

din dreapta spre stânga. 

 

Mărirea grilei arată ca în figura de mai jos: 
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Putem să vizualizăm şi anumite părŃi ale grilei alegând din lista de suprafeŃe. Se face clic din 

nou pe Display şi apoi se vizualizează părŃile selectate. De exemplu: wall, outlet şi centerline. 

 

Avem: 
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În cazul în care avem mai multe limite, putem să le selectăm sau să le deselectăm pe toaate 

folosind butoanele  de lângă Surfaces. 

 

Difinirea proprietăŃilor solverului 

Main Menu > Define > Models > Solver 

Vom alege Axisymmetric din lista de sub Space. Vom folosi setările prestabilite ale 

solverului segregat, formulare implicită, curgere staŃionară şi viteză absolută. 

 

Main Menu > Define > Models > Viscous 

Curgerea laminară este predefinită, deci nu avem nevoie să schimbăm nimic în acest 

menu. Clic Cancel. 

Main Menu > Define > Models > Energy 
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Pentru fluidele incompresibile, ecuaŃia energiei este decuplată de la continuitate şi de 

la ecuaŃia momentului. EcuaŃia o vom activa numai atunci când dorim să observăm distribuŃia 

temperaturii. În exemplul nostru nu este necesar. Lăsăm deci Energy Ecuation deselectat şi 

facem clic pe Cancel pentru anulare. 

 

 

Definirea proprietăŃilor materialelor 

Main Menu > Define > Materials… 

Îi dăm densităŃii valoarea 1 şi viscozităŃii 2e-3. Acestea sunt valorile care sunt 

specificare în problema noastră. Le vom considera pe amândouă constante. Facem clic apoi 

pe Change/Create 

 

Definirea condiŃiilor de operare 

Main Menu > Define > Operating Conditions 

Pentru toate curgerile, Fluentul foloseşte măsura presiunii interioare. De fiecare dată 

când este nevoie de presiunea absolută, ea este generată prin adăugarea presiunii de operare la 

presiunea măsurată. Vom folosi valoarea predefinită de 1 atm. (101,325 Pa) ca presiune de 

operare. 

 

 

Definirea condiŃiilor la limită 

Vom stabili în continuare valoarea vitezei la intrare şi a presiunii la ieşire. 

Main Menu > Define > Boundary Conditions… 
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Aducem aminte că cele tipuri de limite pe care le-am definit sunt specificate ca zone 

în partea de stângă a ferestrei condiŃiilor la limită. Zona centerline ar trebui să fie selectată 

automat. În cazul în care nu este, trebuie să ne asigurăm că tipul acestei limite este axă (axis 

din lista). Apoi se face clic pe Set. Observăm că nu este nici o setare de făcut decât numele pe 

care, în cazul nostru, îl vom lăsa centerline.  

Apoi, mai jos, în listă selectăm inlet. Observăm că Fluent-ul indică că tipul acestei 

limite este velocity-inlet. Ne amintim că aceasta a fost deja stabilită în Gambit. Dacă este 

necesar, putem schimba tipul limitei stabilită anterior în Gambit în acest meniu prin 

selectarea diferitelor tipuri din dreapta. 

   

Facem clic pe inlet apoi Set...  Se va deschide o nouă mini-fereastră. Vom adăuga 

valoarea 1 la Velocity Magnitude (mărimea vitezei). Aceasta setează viteza cu care fluidul 

intră în conductă prin limita din stânga. 

Presiunea (absolută) la ieşire este de 1 atm. Din moment ce presiunea de operare este 

stabilită ca fiind 1atm, mărimea presiunii la ieşire = presiunea absolută la ieşire – presiunea 

de operare = 0. Alegem din listă outlet. Tipul acestei limite este pressure-outlet. Facem clic 

pe Set... Valoarea prestabilită a Gauge Pressure (mărirea presiunii) este 0. Nu facem nici o 

modificare şi închidem fereastra. 
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În final selectăm wall şi ne asigurăm că tipul acestei limite este tot wall (perete). 

Facem clic pe fiecare buton unde avem: Momentum, Thermal, Radiation, Species etc. şi vom 

observa că numai la Momentul putem schimba în urma condiŃiilor stabilite până acum.  

Închidem meniul Boundary Contitions. 
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PASUL 5: REZOLVAREA 

Vom folosi o schemă de discretizare de ordinul doi. 

Main Menu > Solve > Controls > Solution… 

Schimbăm valoarea momentul din ordinul I în ordinul II (Second Order Upwind) 

 

 

Se face prima presupunere 

Se iniŃializează câmpul curgerii cu valorile de la intrare: 

Main Menu > Solve > Initialize… 

În meniul Solution Initialization la Compute From vom alege inlet. Viteza axială 

(Axial Velocity) pentru toate celulele va fi setată la 1 m/s, viteza radială (Radial Velocity) va 

fi 0 m/s. Aceste valori au fost luate de la condiŃiile limită la intrare. 

 

Facem clic pe Init pentru a iniŃializa, apoi Apply şi, în final, Close. 

 

Setarea crierului ce convergenŃă 
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Fluentul face raportul la reziduul pentru fiecare ecuaŃie ce urmează a fi rezolvată. 

Reziduul este măsura la cât de mult satisface soluŃia curentă forma discretizantă a fiecărei 

ecuaŃii ce guvernează. Vom itera soluŃia până când reziduul fiecărei ecuaŃii scade sub 1 · 10-6. 

Main Menu > Solve > Monitors > Residual… 

Schimbăm reziduul pentru continuity, x-velocity şi y-velocity, toate cu valoarea 1e-

6. După aceasta, pentru vizualizare, se face clic pe Plot. Acesta va face graficul reziduurilor 

în fereastra grafică după cum sunt ele calculate. 

 

 

Dacă vă apar erori de tipul “Error: FLUENT received a fatal signal 

(SEGMENTATION VIOLATION)” sau „Error: floating point error: divide by zero” 

înseamnă că placa video este configurată pentru funcŃionarea calculatorului cu viteză şi nu 

pentru performanŃă. ConsultaŃi un expert pentru soluŃionarea unei astfel de probleme. 

 
Am terminat specificaŃiile problemei. Salvăm totul: 

Main Menu > File > Write > Case… 

Salvăm cu numele pipe.cas pentru fişierele de tip case. Verificăm apoi dacă s-a salvat în 

folderul de lucru. Dacă închidem Fluent-ul acum, putem continua cu tot ceea ce am stabilit 

până acum. 

 

Iterăm până la convergenŃă 

Vom porni calcularea făcând 100 de iteraŃii: 

Main Menu > Solve > Iterate 
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În fereastra de iteraŃii (Iterate Window) schimbăm numărul de iteraŃii de la 1 la 100 

apoi facem click pe Iterate. 

Reziduurile pentru fiecare iteraŃie sunt afişate şi listate în fereastra de grafice după 

cum sunt ele calculate. 

 

Reziduurile ajung la criteriul de convergenŃă specificat (1 · 10-6) la 46 de iteraŃii. 

  iter     time/iter 

!  46 solution is converged 

Se salvează soluŃia ca un fişier dată: 

Main Menu > File > Write > Data… 

Introducem la nume pipe.dat. Din nou, se verifică dacă fişierul a fost salvat în folderul de 

lucru. Din acest moment se pot determina soluŃiile de fiecare dată folosind acest fişier. 
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PASUL 6: VITEZA LA CENTRU 

Vom afişa variaŃia vitezei axiale de-a lungul liniei de centru. 

Main Menu > Plot > XY Plot… 

Ne asigurăm că în mini-fereastră, la Options avem selectat Position on X Axis, şi că 

X este setat la 1 iar Y este 0 la Plot Direction (direcŃia de afişare). Asta înseamnă că Fluentul 

va afişa valorile lui x pe abscisa graficului. 

La Y Axis Function, alegem Velocity iar mai jos vom alege Axial Velocity (Viteză 

axială). 

Trebuie de ştiut faptul că X Axis Function şi Y Axis Function descriu axele X şi Y 

ale graficului care nu trebuie confundate cu direcŃiile X şi Y ale conductei. 

În final, vom alege, în cadrul Surfaces, centerline (linie de centru) din moment ce 

dorim să Ńtim viteza axială de-a lungul liniei de centru. Mini-fereastra trebuie să arate ca în 

figura de mai jos: 

 

Facem clic apoi pe Plot. 

Aceasta generează graficul vitezei axiale ca o funcŃie de distanŃă de-a lungul axei 

centrale a conductei. 

Figura care generează este afişată mai jos: 
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În graficul de mai sus se poate vedea că viteza are o valoare constantă după ce parcurge o 

anumită distanŃă de la intrare. Aceasta este zona cu curgerea dezvoltată în totalitate. 

Schimbăm măsura axelor: În mini-fereastra Solution X-Y Plot, facem clic pe Axes... 

La Options, vom deselecta Auto Range (aranjament automat). În dreapta, la Range vom 

avea posibilitatea să introducem valori, astfel, la Minimum vom introduce 1 iar la 

Maximum 3. La Axis trebuie să fie activat X. 

  

Vom activa liniile grilei pentru a ne ajuta să estimăm unde se află curgerea dezvoltată 

complet. Vom selecta, tot în aceeaşi mini-fereastră, Major Rules şi Minor Rules. Apoi se 

face clic pe Apply. 

În continuare, vom selecta Y la Axis şi, din nou, deselectăm Auto Range, apoi 

introducem 1.8 la Minimum şi 2.0 la Maximum. De altfel, selectăm Major Rules şi Minor 

Rules pentru a activa liniile grilei de-a lungul direcŃiei Y. Am terminat acum de specificat 

distanŃa pentru fiecare axă, facem clic pe Apply şi apoi Cancel. 

Ne întoarcem la mini-fereastra Solution XY Plot şi facem clic pe Plot pentru a reafişa 

graficul cu modificările făcute. Putem observa că regiunea complet dezvoltată apare după 3 

metri de la intrarea din conductă şi că viteza de-a lungul axei centrale este de 1,93 m/s. 
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Salvarea graficului 

Salvăm datele din acest grafic: 

În mini-fereastra Solution XY Plot Window, selectăm Write to file (scrie în fişier). 

Acum butonul Plot este schimbat în Write (scrie). Facem clic pe Write... Introducem ve1.xy 

la XY File şi apoi OK. Verificăm dacă fişierul a fost creat în folderul de lucru.  

În continuare vom face o captură a imaginii: 

Vom lăsa graficul în continuare deschis, iar dacă l-am închis, îl vom deschide din nou 

şi vom deschide fereastra principală a fluentului. 

Vom intra în File > Hardcopy 

În căsuŃa Format, avem mai multe tipuri de fişiere. Vom alege una dintre: 

- EPS – în cazul în care avem vizualizare generată de text, acesta este cea mai bună 

alegere. EPS ne permite să salvăm fişierul păstrând forma vectorială, opŃiune ce ne 

oferă o calitate foarte bună a imaginii din cauza „alunecării” la infinit a vectorilor. 

După ce selectăm EPS, vom alege Vector la File Type (Tipul fişierului); 

- TIFF – acesta oferă o rezoluŃie foarte bună a imaginii graficului. DiferenŃa se observă 

la dimensiunea fişierului care va fi mare deci este nerecomandată pentru 

calculatoarele cu memorie mică de stocare; 

- JPG – are dimensiune mică şi poate vi vizualizat de către toate navigatoarele. 

Dezavantajul principal în folosirea acestui tip este rezoluŃia mică. 

 

După ce am selectat formatul imaginii dorit şi opŃiunile de rigoare, vom face clic pe 

Save... 

Vom introduce vel.eps, vel.tif sau vel.jpg, în funcŃie de formatul ales. 
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Vom verifica în continuare dacă fişierul a fost salvat în folderul de lucru. De aici poate fi 

copiate în orice altă destinaŃie deoarece este un fişier total independent de Fluent. 

 

Coeficientul de frecare la limită 

Fluentul ne oferă foarte multe informaŃii şi ajutor on-line. Vom face o probă pentru a 

intra în contact cu ajutorul oferit de fluent. Vom începe, bineînŃeles, cu calcularea 

coeficietului de frecare la limită. 

Main Menu > Help > User`s Guide Index... 

Facem clic pe S la legături şi vom derula în jos până la skin friction coeffiecient. 

Facem apoi clic pe legătura 965 (normal ar trebui să căutam pas cu pas ceea ce avem nevoie). 

Vom observa un fragment din coeficientul de frecare la limita precum şi ecuaŃia de rezolvare 

a lui. 

Facem clic pe Reference Values (valori de referinŃă) pentru a primi instrucŃiuni în legătură 

cu utilizarea valorilor de referinŃă utilizate pentru calcularea coeficientului. 

 

 

Stabilim valorile de referinŃă: 

Main Menu > Report > Reference Values… 

Selectăm inlet la Compute From (calculează din) pentru a da indicaŃii programului 

de a calcula valorile de referinŃă cu valorile de la intrare. Verificăm dacă densitatea este 

1kg/m3 şi dacă viteza este de 1 m/s. 
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Mergem înapoi la Solution XY Plot, deselectăm Write to File deoarece vrem să 

afişăm în program graficul. Vom lăsa celelalte opŃiuni aşa cum sunt ele din moment ce afişăm 

de-a lungul direcŃiei X a conductei. 

La Y Axis Function, alegem Wall Fluxes... (Fluxul din pereŃi) şi apoi Skin Friction 

Coefficient din căsuŃa de dedesubt. 

La Surfaces alegem wall şi deselectăm centerline. 

Resetăm mărimea axelor: Mergem la Axes... şi reselectăm Auto-Range pentru axa Y. 

Vom alege mărimea axei X dându-i valoarea 8. Vom selecta X sub Axis şi vom introduce 1 la 

Minimum şi 8 la Maximum în căsuŃa Range (Nu trebuie să uitam să deselectăm Auto-

Range). 

Facem clic pe Apply, apoi Close şi, în final, Plot. 

Vom avea un grafic ca în figura de mai jos: 
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Putem observa că zona complet dezvoltată se află la distanŃa de x = 3 m faŃă de zona 

de intrare şi că coeficientul de frecare la limită în această zonă este de 1,54. Comparăm 

valoarea numeric 1,54 cu cea teoretică a zonei complet dezvoltată care are valoarea de 0,16. 

Salvăm informaŃia de pe acest grafic. Alegem Write to File din Options şi apoi 

facem clic pe Write... Introducem la nume cf.xz şi apoi OK. 

 

Profilul de viteză 

În continuare vom afişa graficul vitezei la ieşirea din conductă ca o funcŃie de distanŃă 

de la centru. Pentru a face aceasta, avem nevoie să stabilim axa y a graficului să corespundă 

cu axa y a conductei (în direcŃia radială). 

Pentru a afişa poziŃia care variază de-a lungul axei y a graficului, deselectăm  

Position on X Axis din căsuŃa Options şi în loc, vom selecta Position on Y Axis. Pentru a 

face distanŃa radială să varieze cu linia de centru, la Plot Direction, vom introduce la X 

valoarea 0 iar la Y valoarea 1. Pentru a afişa viteza axială pe axa x a graficului, pentru X Axis 

Function vom alege Velocity... şi Axial Velocity în căsuŃa de mai jos.  

Din moment ce vrem să afişăm viteza la ieşire, vom alege outlet din cadrul Surfaces. 

Vom schimba axele x şi y cu Auto-Range. 

 

Deselectăm Write to File şi facem clic pe Plot 

Rezultatul este un grafic care arată ca în figura de mai jos: 
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Rezultatul ar trebui să fie un profil parabolic. 

Salvăm informaŃia din acest grafic: selectăm Write to File şi apoi facem clic pe 

Write... La numele fişierului vom scrie profile.xy. 

Pentru a vedea cum se schimbă profilul în zona complet dezvoltată, vom adăuga 

graficului de mai sus profilul la x = 0,6 m (x/D=3) şi x = 0,12 m (x/D=6). Pentru început, 

vom crea o linie la x = 0,6m utilizând instrumentul Line/Rake (Linie/Pieptene) 

Main Menu > Surface > Line/Rake 

Vom crea o linie dreaptă de la (x0,y0) = (0.6,0) la (x1,y1) = (0.6,0.1). Selectăm Line 

Tool din căsuŃa Option. Introducem la x0 = 0.6, y0 = 0, x1 = 0.6 şi y1 = 0.1 iar la New 

Surface Name (numele suprafeŃei) vom scrie line1. 

 

Pentru a vizualiza linia nou creată vom alege: 

Main Menu > Display > Grid 

Observăm line1 în lista din căsuŃa Surfaces.  

Selectăm toate elementele din listă cu excepŃia default-interior. Facem clic pe 

Display. Aceasta va afişa toate suprafeŃele mai puŃin celulele din mesh.  
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Mărim apoi zona apropiată zonei de intrare pentru a observa linia creată la x = 0.6 m. 

Linia nou creată, Line1, este reprezentată vertical, în partea dreaptă, cu culoare albă, ca în 

figura de mai jos: 

 

Vom crea prin aceiaşi metodă o linie verticală pe care o vom numi line2 la x = 1.2; (x0,y0) = 

(1.2,0) la (x1,y1) = (1.2,0.1) în acest caz. Vom afişa în fereastra grafică pentru a verifica dacă 

s-a creat corect. 

Acum putem afişa profilul de viteză la x = 0,6 m (x/D=3) şi x = 0,12 m (x/D=6) de-a 

lungul profilului de la ieşirea din conductă. Deschidem din nou mini-fereasta Solution XY 

Plot şi folosi aceleaşi valori ca cele de mai sus. În căsuŃa Surfaces, pe lândă outlet vom 

selecta line1 şi line2. Selectăm Node Values (Valorile nodului) şi apoi facem clic pe Plot. 

Simbolurile ar putea apărea diferit de cele din figura de mai jos. 
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Putem să schimbăm simbolurile şi stilurile liniilor în meniul Curves. În cazul în care 

întâmpinăm probleme, facem clic pe Help din meniul Curves. 

 

Vectorii viteză 

Putem afişa vectorii din întreaga zonă sau din anumite părŃi. Pentru exemplificare 

vom afişa vectorii de viteză pentru întreaga zonă pentru a observa cum se dezvoltă fluidul pe 

toată zona, de la intrare şi până la ieşire. 

Main Menu > Display > Vectors…>Display 

Mărim regiunea din vecinătatea zonei de intrare. Lungimea şi culoarea săgeŃilor 

reprezintă viteza. Vectorii pot fi vizualizaŃi mai uşor modificând scara. La Scale vom 

introduce 0.4 după care se face clic pe Display. 

 

Putem vizualiza de altfel şi secŃiuni ale conductei: 

Main Menu > Display > Views… 

La Mirror Planes (Planuri în oglindă), este afişat doar centerline în căsuŃa Surfaces. 

Selectăm centerline după care facem clic pe Apply. Închidem minifereastra Views. 
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Vom avea un grafic ca în figura de mai jos: 

 

Vectorii viteză ne arată cum se dezvoltă curgerea în conductă. O dată cu creşterea 

stratului limită, curgerea la limita peretelui este încetinită/deviată de frecarea vâscoasă. Putem 

observa foarte clar vectorii înclinaŃi în zona de intrare, pe lângă perete. Aceasta arată că 

încetinirea curgerii în apropierea peretelui rezultă prin injectarea fluidului în zona depărtată 

de perete pentru a satisface conservarea masei. Astfel viteza din afara stratului limită creşte.  

 

Din setările iniŃiale, un vector este desenat în centrul fiecărei celule. Aceasta poate fi 

vizibilă prin activarea grilei de vectori. Selectăm Draw Grid din meniul Vectors şi apoi 

facem clic pe Display.  
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PASUL 7 – CURĂłIREA MESHURILOR 

Este foarte important să se facă evaluarea dependenŃei rezultatelor meshurilor folosite prin 

repetarea unor calule pe diferite meshuri, făndu-se comparaŃia. Vom reconstrui calculele 

anterioare cu un mesh de dimensiunile 100x10. Dacă dorim să sărim peste pasul de 

modificare a meshurilor, putem descărca meshurile din Gambit şi importate direct în Fluent. 

 

Modificarea Meshurilor în Gambit 

Meshul 100x5 este salvat cu denumirea de pipe.dbs în folderul de lucru. Vom deschide 

fereastra de comandă ca şi la pasul 1. Pentru a copia pipe.dbs, se folosesşte comanda: 

Copy pipe.dbs pipe2.dbs 

Unde: pipe2.dbs este noul nume a fişierului copiat. 

Vom lucra cu pipe2.dbs pentru a nu modifica pipe.dbs. Deschidem pipe2.dbs cu Gambitul, 

folosind următoarea comandă: 

gambit pipe2.dbs 

De Ńinut minte faptul că pipe2 este ID-ul programului de lucru, deci toate fişierele create în 

această sesiune vor avea acest prefix. 

Vom şterge meshurile feŃei şi vom modifica meshurile feŃelor (laturilor) şi vom remesha faŃa. 

Pentru a şterge meshurilor feŃei originale, vom alege 

Operation Toolpad > Mesh Command Button > Face Command Button  > 

Delete Face Meshes  

În fereastra Delete Face Meshes care se va deschide vom deselecta Remove unused lower 

mesh. Aceasta dictează programului să şteargă doar meshurile feŃei şi menŃine meshurile 

feŃelor atribuite fiecărei feŃe. Din moment ce vom schimba meshurile a două feŃe ale 

drepunghiului, nu este nevoie să refacem meshurile celor patru laturi. 

Selectăm singura faŃă a dreptunghiului cu ajutorul tastei Shift după care facem clic pe Apply. 

 

 

Modificarea meshurilor feŃelor 
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Pentru a schimba numărul de diviziuni ale laturilor verticale din 5, 10, alegem: 

Operation Toolpad > Mesh Command Button  > Edge Command Button  > 

Mesh Edges  

 

Selectăm cele două laturi verticale cu ajutorul tastei Shift, făcând clic pe fiecare în 

parte, după care dăm drumul. Selectăm Interval Count din căsuŃă, sub Spacing pe care scrie 

Interval Size. Schimbăm numărul, din 5 în 10. 

Ne asigurăm din nou că opŃiunea Remove old mesh este deselectată din mini-

fereastra Option. Asta ne asigură că meshurile vechi ale laturilor sunt şterse înainte ca cele 

noi să fie create. 

Facem clic apoi pe Apply. 

 

A nu se uita că putem mări desenul prin Ńinerea apăsat a tastei Ctrl, şi apoi, cu mouseul, se 

fac secŃiunile de mărire a zonelor dorite. Putem observa acum cele 10 diviziuni 
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Reconstruirea meshurilor feŃelor 

Operation Toolpad > Mesh Command Button  > Face Command Button  > 

Mesh Face  

 

 

Salvarea şi Exportarea 

Main Menu > File > Save 

Main Menu > File > Export > Mesh… 

Scriem pipe2.msh la File Name: şi selectăm Export 2d Mesh după care Appy. 

 

Analiza fină a meshurilor (finisarea meshurilor) 

Repetăm paşii 4 şi 5 folosind meshurile 100x10. 
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Cand obŃinem soluŃia, afişăm variaŃia vitezei la centru de-a lungul axei X după cum 

am descris şi la pasul 6. Comparăm rezultatele noi cu cele anterioare, care au fost salvate cu 

vel.xy. Pentru a face asta, după ce am afişat viteza la centru, facem clic pe Load File... în 

mini-fereastra Solution XY. Deschidem folderul de lucru şi facem clic pe vel.xy după care 

Ok şi, în final, Plot. 

În fereastra cu grafice putem observa ambele rezultate pe acelaşi grafic. Modificăm 

axele pentru a putea mări zona de început a regiunii complet dezvoltată. 

 

Pe graficul vitezei la centru de mai sus, simbolurile cu alb şi roşu reprezintă rezultele 

meshurile de dimensiunile 100x10 respectiv 100x5. Viteza la centru în regiunea dezvoltată 

complet este de 1,98 m/s. Această valoare corespunde mai degraba cu valoarea analitică de 2 

m/s decât cu valoarea 1,93 m/s obŃinută pe meshul brut. Salvăm aceste date ca vel2.xy. Viteza 

rezultată devine mai exactă în timpul finisării meshurilor după cum era de aşteptat. 

 

Afişăm coeficientul de frecare la limită ca şi la pasul 6. Comparând rezultatele avem: 
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Finisarea meshurilor ne oferă un coeficient de frecare la limită de 0,159 în zona 

complet dezvoltată, care este mult mai apropiată de valoarea teoretică de 0,16 decât celei de 

0,154 la meshurile brute. Salvăm datele cu numele de cf2.xy. 

Analog, afişăm profilul de viteză la ieşire şi comparăm cu cel făcum pe meshrile 

brute. Salvăm ca out.xy. Cele două rezultate sunt comparate foarte bine cu cea mai mare 

deviaŃie de la centru. Salvăm datele ca out2.xy. 
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PROBLEMA 1: 

Problema: 

a) Considerăm problema rezolvată în acest laborator. La ieşirea din conductă, putem 

defini eroarea calculelor pentru viteza centrală astfel: 

ε = | Uc – Uexact| 

unde:  

Uc – valoarea liniei de centru din Fluent; 

Uexact – valoarea analitică exactă pentru zona complet dezvoltată. 

Eroarea rezultată trebuie să aibă formă: 

ε = K∆rp 

unde coeficientul K şi puterea p depind de metoda folosită. Considerăm soluŃia obŃinută 

pentru meshurile de dimensiunile 100x5, 100x10 şi 100x20. Cu ajutorul Matlab-ului, folosim 

metoda celor mai mici pătrate 

lnε = lnK + pln∆r 

pentru a obŃine coeficienŃii K şi p. Valoarea lui Uexact poate fi găsită în diferite cărŃi de fluido-

mecanică precum Fluid Mechanics de F. Wshite. La final, trebuie să demonstraŃi de ce 

valorile voastre au sens. 

b) RepetaŃi exerciŃiul de mai sus folosind schema „first-order upwind”  pentru ecuaŃia 

momentului. ComparaŃi valoarea lui p obŃinută în acest caz cu cea precedentă şi 

explicaŃi în amănunt (2-3 fraze) rezultatele. 

 

ObservaŃi că discretizarea de primul şi al doilea ordin se aplică numai în termen 

convectiv în ecuaŃiile Navier-Stokes. Viscozitatea este întotdeauna de ordinul doi, pentru 

precizie. 
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PROBLEMA 2 

Problema: 

Pe cel mai curat mesh (100x20), refaceŃi calculele pentru Re=200 şi Re=500 folosind schema 

„second order upwind”. ObservaŃie: schimbaŃi numărul Reynolds prin ajustarea viscozităŃii 

moleculare µ. AfişaŃi viteza la centru şi frecarea la limită ca o funcŃie de distanŃa axială 

pentru Re = 100 (problema anterioară), 200 şi 500. AfişaŃi cele trei cazuri pe acelaşi grafic 

pentru comparaŃie. ExplicaŃi pe scurt ce observaŃi atunci când numărul lui Reynolds creşte. 

 

Sfaturi: Dacă nu aŃi salvat meshul 100x20 în pasul 7, puteŃi sa-l încărcaŃi în fluent din 

nou fără a fi necesară reconstruirea lui în Gambit. 

RezolvaŃi µ pentru fiecare număr Reynolds la început apoi gândiŃi-vă ce paşi ar trebui să fie 

schimbaŃi. 

 



 

 

 

 

 

 

CURGEREA TURBULENTĂ ÎN 
CONDUCTE 
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SpecificaŃiile problemei: 

1. Crearea geometriei în Gambit; 
2. Masharea geometriei în Gambit; 
3. Specificarea tipurilor de limită în Gambit; 
4. Stabilirea Problemei in Fluent; 
5. Rezolvarea; 
6. Analiza rezultatelor; 
7. Finisarea meshurilor. 

Problema 1. 

Specificarea problemei 

 

Acest exerciŃiu este construit pe baza datelor generale ale problemei anterioare. La fel, viteza de intrare 

Vin este de 1m/s, evacuarea fluidului în atmosferă şi densitatea este de 1kg/m3. Pentru µ= 2 · 10-5
 

kg/ms, numărul Raynolds în funcŃie de diametru şi viteza medie la intrarea în conductă este de: 

ReD = 
ρVavgD

µ  = 100 000 

La această valoare, în general, curgerea este în totalitate turbulentă.  

Curgerea turbulentă manifestă mici fluctuaŃii în timp. Aceste fluctuaŃii sunt uneori imposibil de 

rezolvat în calculele de tip CFD (Computer Fluid-Dynamics), deci variabilele curgerii precum viteza, 

presiunea etc. sunt pentru un timp mediu. Din păcate,  ecuaŃiile pe baza timpului mediu nu sunt închise 

adică ele conŃin cantităŃi fluctuante care trebuie modelate folosind un model de turbulenŃă. Nici un 

model de turbulenŃă nu este încă disponibil pentru toate tipurile de curgeri şi deci este necesar să 

alegem un model fin sau clase particulare de curgeri. În acest exerciŃiu vom folosi modelul de tipul k-ε. 

Dar, în exemplele reale, trebuie luată o măsură foarte importantă: trebuie evaluată validitatea calculelor 

folosind modelul de turbulenŃă cu grijă. 

Vin 
D 

d = 0,2 
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Fluentul nu trebui utilizat ca o „cutie neagră”. Modelele k-ε constau în două ecuaŃii diferenŃiale: 

una pentru energia cinetică k şi una pentru dispersia turbulentă ε. Aceste două ecuaŃii trebuie să fie 

rezolvate folosind continuitatea timpului mediu, momentul şi ecuaŃia energiei. Deci, calculele curgerii 

turbluente sunt mult mai dificile şi costisitoare decât calculele regimului laminar. 
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PASUL 1. CREAREA GEOMETRIEI ÎN GAMBIT 

Deoarece curgerea este axisimetrică, geometria este un dreptunghi că şi la primul exerciŃiu. 

Vom folosi pentru început un mesh de mărimea 100x30, adică 100 de diviziuni în direcŃia axială şi 30 

diviziuni în cea radială. 

Putem construi acest mesh de la 0 dar, în loc, îl vom modifica pe cel de la primul exerciŃiu şi 

anume din 100x5, în 100x30. Aceasta ne introduce în „arta modificării meshurilor” în Gambit. 
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PASUL 2: GEOMETRIA MESHULUI ÎN GAMBIT 

Deschiderea GAMBITULUI 

Vom crea un folder cu denumirea pipe2 într-o locaŃie convenabilă pentru a-l folosi drept folder 

de lucru. Copiem pipe.dbs (fişierul care conŃine meshul 100x5) din laboratorul anterior în acest folder. 

Denumim fişierul ca pipe100x30.dbs. Vom modifica acest fişier pentru a obŃine meshul pentru 

simularea curgerii turbulente în conducte. 

Pornim GAMBIT-ul în folderul de lucru cu comanda gambit –id pipe100x30 din prompterul de 

comenzi ale windowsului (a se revedea laboratorul anterior). GAMBIT-ul va folosi id-ul pipe100x30 ac 

prefix predefinit pentru toate fişierele care vor fi create în această sesiune. În continuare va afişat 

meshul creat anterior. Pentru a cuprinde tot meshul în fereastra, vom selecta:  

 

 „Fit to Screen”   din meniul „Global Control” 

Ştergerea meshurilor de pe feŃe create anterior 

Primul pas pe care trebuie să-l parcurgem este ştergerea vechiul mesh de pe faŃă. Să nu uităm faptul că 

meshul de pe faŃă este construit deasupra meshurilor laturilor, deci formează grid-ul. În acest caz nu 

vrem să ştergem meshurile laturilor. Pentru a şterge numai meshurile feŃelor, selectăm: 

Operation Toolpad > Mesh Command Button  > Face Command Button  > Delete Face 

Meshes  
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Deoarece avem o singură faŃă, facem clic, Ńinând apăsată tasta SHIFT, pe fiecare latură care formează 

faŃa pentru a o selecta. FaŃa selectată apare cu culoare roşie iar numele ei apare în meniu, la „Delete 

Face Meshes”. 

Pentru că nu vrem să ştergem şi laturile, deselectăm „Remove unused lower mesh”. 

 

Facem clic apoi pe Apply 

Remesharea laturilor 

Deoarece vom folosi din nou 100 de diviziuni pentru laturile orizontale, vom modifica doar cele 

verticale. 

Pentru a avea un gradient mai puternic lângă perete, pentru curgerea turbulentă, vom folosi un 

spaŃiu mai mic între ochiurile grilei prin strângerea lui. 

Pentru fiecare latură verticală, vom specifică lungimea diviziunilor de lângă perete ca fiind de 

0,001 şi numărul total de diviziuni de 30. În GAMBIT, fiecare latură are o direcŃie asociată cu ea, după 

cum ne arată săgeata. Vom muta această săgeată mai departe de perete astfel încât diviziunea apropiată 

peretelui devine „prima lungime” şi cea de-a doua devine „ultima lungime”. Vom da apoi valoarea  

primei lungimi de 0,001 şi 30 numărului total de diviziuni pentru latură; Gambitul va calcula valoare 

aproximativă a ultimei lungimi. 

Operation Toolpad > Mesh Command Button  > Edge Command Button  
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Selectăm laturile verticale. Observăm săgeata roşie care apare pe latura selectată. Trebuie să ne 

asigurăm că direcŃia ei este în jos. Dacă ambele săgeŃi sunt îndreptate în direcŃii greşite, le putem 

corecta cu ajutorul comenzii „Reverse” din meniul „Mesh Edges” 

 

Dacă săgeata uneia dintre laturi trebuie întoarsă, o putem face şi cu ajutorul tastei SHIFT şi 

Ńinând clic pe RotiŃa Mouselui. 

La „Type” în meniul „Mesh Edges”, selectăm „First Length” (prima faŃă) din listă. Lângă 

„Length”, introducem valoarea 0,001 
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În continuare vom împărŃi fiecare latură verticală în 30 de diviziuni. Selectăm „Interval Count” şi 

introducem valoarea 30.  

 

 

Meniul şi latura arată ca în figurile de mai jos: 
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Observăm că spaŃiul meshurilor este mai mic lângă perete după cum sunt aşezate cercurile 
albastre. 

ReconstrucŃia meshurilor feŃelor 

Următorul pas este reconstrucŃia meshurilor feŃelor. 

Operation Toolpad > Mesh Command Button  > Face Command Button  > Mesh Face 

 

Selectăm faŃa şi apoi facem clic pe „Apply”. SuprafaŃa meshată arată ca în figura de mai jos: 
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PASUL 3: SPECIFICAREA TIPURILOR DE LIMITĂ ÎN GAMBIT 

Tipurile de limită au fost creat în laboratorul anterior şi anume: 

POZIłIA LATUREI NUMELE TIPUL 

Stânga inlet VELOCITY_INLET 

Dreapta outlet PRESSURE_OUTLET 

Sus wall  WALL 

Jos centerline  AXIS 

Aceste tipuri de limită au rămas la fel chiar dacă s-a modificat meshul de pe fiecare latura. Verificăm 

dacă acestea s-au păstrat: 

Operation Toopad > Zones Command Button  > Specify Boundary Types Command Button 

 

 

Dacă dorim să vedem toate limitele pe fereastra principală, selectăm „Show labels” din meniu iar în 

fereastra principală vor fi reprezentate denumirile cu galben, ca în figura de mai jos: 
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Salvarea şi exportarea 

Ca şi în laboratorul anterior, vom salva şi exporta meshul: 

Main Meniu > File > Save 

şi 

Main Menu > File > Export > Mesh… 

La „File Name:” vom scrie pipe100x30. Selectăm „Export 2d Mesh” deoarece acesta este un mesh 

bidimensional. Apoi clic Accept 

Verificăm dacă pipe100x30.msh a fost creat în folderul de lucru. 

Ieşim din GAMBIT: 

Main Meniu > File > Exit şi salvăm sesiunea. 
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PASUL 4: INTRODUCEREA PROBLEMEI ÎN FLUENT 

Deschidem FLUENT 

Start > Programs > Fluent Inc > Fluent 6.x.xx 

 

Selectăm 2ddp (2D, precizie dublă) din listă şi apoi facem clic pe Run. 

Importarea fişierului 

Main Menu > File > Read > Case… 

Intrăm în folderul de lucru şi selectăm pipe100x30.msh. Facem clic apoi pe OK. 

În fereastra principală va apărea: 
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Verificăm numărul de noduri, feŃe (de tipuri diferite) şi celule. Sunt 3000 de celule patrulatere. Acesta 

este numărul la care ne aşteptam deoarece folosim 30 de diviziuni în direcŃia radială şi 100 în cea 

axială. Deci numărul total de celule este 30 x 100 = 3000 

De altfel, ne uităm şi la zone. Putem observa cele patru zone: inlet, wall, outlet şi centerline. 

 

Grila  

Pentru început verificăm grila pentru a fi siguri că nu sunt erori. 

Verificarea se face din meniul: 

Main Menu > Grid > Check  

Orice eroare întâlnită va fi reportată imediat. Verificăm apoi ieşirea pentru a fi siguri că nici 

acolo nu avem erori. Apoi se face verificarea dimensiunii grilei: 

Main Menu > Grid > Info > Size 

Aceasta arată ca în figura de mai jos: 

 

Vizualizăm grila: 

Main Menu > Display > Grid 

Trebuie să ne asigurăm că toate suprafeŃele (Surfaces) sunt selectate. Apoi facem clic pe 

Display. O nouă fereastră în care vom observa grila se va deschide. Se va închide apoi făcând click pe 

Close. 
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Putem să vizualizăm şi anumite părŃi ale grilei alegând din lista de suprafeŃe. Se face clic din 

nou pe Display şi apoi se vizualizează părŃile selectate. Este indicat să folosim această particularitate şi 

să ne asigurăm că etichetele limitelor corespund cu entităŃile geometrice. 

Închidem fereastra „Grid Display”. 

Difinirea proprietăŃilor solverului 

Main Menu > Define > Models > Solver 

Vom alege Axisymmetric din lista de sub Space. Ca şi la problema anterioară, vom folosi 

setările prestabilite ale solverului segregat, formulare implicită, curgere staŃionară şi viteză absolută. 

Main Menu > Define > Models > Viscous 

Selectăm „k-epsilon (2eqn). Observăm că fereastra se lărgeşte, apărând opŃiuni noi atunci când 

selectăm modelul de turbulenŃă k-epsilon. În lista de sub „Near-Wall Tratment”, selectăm „Enhanced 

Wall Treatment” pentru a obŃine un rezultat mai precis. 
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Main Menu > Define > Models > Energy 

Pentru fluidele incompresibile, ecuaŃia energiei este decuplată de la continuitate şi de la ecuaŃia 

momentului. EcuaŃia o vom activa numai atunci când dorim să observăm distribuŃia temperaturii. În 

exemplul nostru nu este necesar. Lăsăm deci Energy Ecuation deselectat şi facem clic pe Cancel 

pentru anulare. 
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Definirea proprietăŃilor materialelor 

Main Menu > Define > Materials… 

Densitatea va avea valoarea 1 şi viscozitatea 2e-5. Acestea sunt valorile care sunt specificare în 

problema noastră. Le vom considera pe amândouă constante. Facem clic apoi pe Change/Create. 

(Numele materialului nu contează în exemplele noastre) 

 

Definirea condiŃiilor de operare 

Main Menu > Define > Operating Conditions 

Pentru toate curgerile, Fluentul foloseşte măsura presiunii interioare. De fiecare dată când este 

nevoie de presiunea absolută, ea este generată prin adăugarea presiunii de operare la presiunea 

măsurată. Vom folosi valoarea predefinită de 1 atm. (101,325 Pa) ca presiune de operare. 
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Definirea condiŃiilor la limită 

Vom stabili în continuare valoarea vitezei la intrare şi a presiunii la ieşire. 

Main Menu > Define > Boundary Conditions… 

Aducem aminte că cele tipuri de limite pe care le-am definit sunt specificate ca zone în partea 

de stângă a ferestrei condiŃiilor la limită. Zona centerline ar trebui să fie selectată automat. În cazul în 

care nu este, trebuie să ne asigurăm că tipul acestei limite este axă (axis din lista). Apoi se face clic pe 

Set. Observăm că nu este nici o setare de făcut decât numele pe care, în cazul nostru, îl vom lăsa 

centerline.  

Apoi, mai jos, în listă selectăm inlet. Observăm că Fluent-ul indică că tipul acestei limite este 

velocity-inlet. Ne amintim că aceasta a fost deja stabilită în Gambit. Dacă este necesar, putem schimba 

tipul limitei stabilită anterior în Gambit în acest meniu prin selectarea diferitelor tipuri din dreapta. 

   

Facem clic pe inlet apoi Set...  Se va deschide o nouă mini-fereastră. Vom adăuga valoarea 1 la 

Velocity Magnitude (mărimea vitezei). Aceasta setează viteza cu care fluidul intră în conductă prin 

limita din stânga (în cazul nostru 1m/s). La „Specification Method” alegem din listă „Intensity and 

Hydraulic Diameter”. La „Turbulence Intensity” vom introduce valoarea 1 iar la „Hydraulic Diameter” 

valoarea 0.2. Clic pe OK pentru a salva noile valori. 
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Presiunea (absolută) la ieşire este de 1 atm. Din moment ce presiunea de operare este stabilită 

ca fiind 1atm, mărimea presiunii la ieşire = presiunea absolută la ieşire – presiunea de operare = 0. 

Alegem din listă outlet. Tipul acestei limite este pressure-outlet. Facem clic pe Set... Valoarea 

prestabilită a Gauge Pressure (mărirea presiunii) este 0. Nu facem nici o modificare şi închidem 

fereastra. 

 

 

Notă: „Backflow” se referă la fluxul care intră la ieşire. Acesta nu este cazul nostru deci nu 

vom introduce nimic.  Închidem meniul „Boundary Conditions”. 
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PASUL 5: REZOLVAREA 

Vom folosi o schemă de discretizare de ordinul doi pentru ecuaŃia de moment, ca şi în 

laboratorul anterior, şi de altfel pentru ecuaŃia energiei cinetică turbulentă care este face parte din 

modelul de turbulenŃă k-epsilon. 

Main Menu > Solve > Controls > Solution… 

Schimbăm valoarea momentul din ordinul I în ordinul II (Second Order Upwind) 

 

Facem clic apoi pe OK. 

Ordinul de discretizare pe care tocmai l-am ales se referă la termenii convectivi în ecuaŃie; 

discretizarea termenilor de viscozitate este întotdeauna de ordinul doi în Fluent pentru acurateŃe mare. 

Discretizarea de ordinul doi duce în general la acurateŃi mari iar cele de ordinul unu duc la convergenŃe 

robuste. Dacă schema de ordinul doi nu CONVERGE, putem încerca iterarea şi cu schema de ordinul I. 

 

Se face prima presupunere 

Se iniŃializează câmpul curgerii cu valorile de la intrare: 

 Main Menu > Solve > Initialize… 
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În meniul Solution Initialization la Compute From vom alege inlet. Viteza axială (Axial 

Velocity) pentru toate celulele va fi setată la 1 m/s, viteza radială (Radial Velocity) va fi 0 m/s. 

Presiunea măsurată (Gauge Pressure) va fi şi ea de 0 Pa. Energia cinetică a turbulenŃei (Turbulence 

Kinetic Energy) şi rata disipării (Dissipation Rate) sunt stabilite din valorile prescrise pentru 

intensitatea turbulenŃei şi diametrul hidraulic la intrare (stabilite anterior). 

 

Facem clic pe Init pentru a iniŃializa, apoi Apply şi, în final, Close. 

Stabilirea crierului ce convergenŃă 

Fluentul face raportul la reziduul pentru fiecare ecuaŃie ce urmează a fi rezolvată. Reziduul este 

măsura la cât de mult satisface soluŃia curentă forma discretizantă a fiecărei ecuaŃii ce guvernează. 

Vom itera soluŃia până când reziduul fiecărei ecuaŃii scade sub 1 · 10-6 (1e-6). 

Main Menu > Solve > Monitors > Residual… 

Observăm că la criteriul de convergenŃă (Convergence Criterion) avem posibilitatea de a 

schimba ecuaŃiile k şi epsilon, pe lângă celelalte trei prezentate în laboratorul anterior. Introducem 

valoarea 1e-06 la toate cele cinci ecuaŃii ce urmează a fi rezolvate. Selectăm Print şi Plot din mini-

fereastră pentru a putea afişa reziduurile. Se face clic apoi pe OK. 
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Aceasta completează specificaŃiile problemei. Salvăm sesiunea astfel:  

Main Menu > File > Write > Case… 

Salvăm cu numele pipe100x30.cas pentru fişierele de tip case. Verificăm apoi dacă s-a salvat în 

folderul de lucru. Dacă închidem Fluent-ul acum, putem continua cu tot ceea ce am stabilit până acum. 

 

Iterăm până la convergenŃă 

Vom porni calcularea făcând 100 de iteraŃii: 

Main Menu > Solve > Iterate 

În fereastra de iteraŃii (Iterate Window) schimbăm numărul de iteraŃii de la 1 la 100 apoi facem 

click pe Iterate. Vom vedea că nu toate reziduurile sunt sub 1e-6 în 100 de iteraŃii. Rezolvăm pentru 

încă 200 de iteraŃii. SoluŃia converge într-un total de 229 iteraŃii. 
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Rezultatul va arăta ca în figura de mai jos: 

 

Avem nevoie de un număr mai mare de iteraŃii pentru convergenŃă pentru curgerea turbulentă 

decât pentru cea laminară din moment ce avem un mesh mult mai finisat şi, de altfel, un număr mai 

mare de ecuaŃii. 

Main Menu > File > Write > Data… 

Introducem la nume pipe100x30.dat. Din nou, se verifică dacă fişierul a fost salvat în folderul 

de lucru. Din acest moment se pot determina soluŃiile de fiecare dată folosind acest fişier. 
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PASUL 6: ANALIZA REZULTATELOR 

y+  

Curgerile turbulente sunt afectate simŃitor de prezenŃa pereŃilor. Modelul de turbulenŃă k-epsilon 

este valid prima dată departe de pereŃi fiind necesar un tratament special pentru a-l face valid în 

apropierea lor. Modelul pentru zona apropiată de pereŃi este dependentă de rezoluŃia grilei care este 

evaluată în unităŃi y+ (definit în secŃiunea 10.9.1 în manualul Fluentului). Nu vom intra în prea multe 

detalii şi vom folosi următoarea regulă de bază: selectăm rezoluŃia zonei de lângă perete astfel: y+ < 30 

şi y+ < 5 pentru celula adiacentă peretelui. A se vedea secŃiunea 10.9 din, „Grid Considerations for 

Turbulent Flow Silmulations” pentru mai multe detalii. 

Pentru început avem nevoie să stabilim câteva valori de referinŃă pentru a calcula y+. 

Din Main Meniu > Report > Reference Values 

Selectăm inlet la Compute From pentru a-i da Fluent-ului valorile la intrarea în conductă ca 

valori de referinŃă. Verificăm dacă valorile de referinŃă sunt: densitate - 1kg/m3 , viteză – 1m/s şi 

coeficient de viscozitate – 2e-05 kg/m·s, după cum apar în specificaŃiile problemei. Aceste valori de 

referinŃă vor fi folosite pentru a adimensiona distanŃa celulei centrale de perete pentru a obŃine valoarea 

corespunzătoare y+. Clic OK. 
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Vom afişa valorile lui y+ pentru celulele adiacente peretelui pentru a verifica comparaŃia cu 

recomandările menŃionate anterior. 

Main Menu > Plot > XY Plot… 

Ne asigurăm că „Position on X Axis” este selectat. La „X” vom avea valoarea 1 şi 0 la Y. 

Aceasta face Fluentul să afişeze valorile pe abscisa graficului. Sub „Y Axis Function”, din listă, vom 

alege „Turbulence” iar dedesubt „Wall Yplus”, ca în figura de mai jos. Deoarece dorim valoarea y+ 

pentru celulele adiacente peretelui conductei, alegem „wall” din lista de suprafeŃe. 
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Facem clic apoi pe Plot pentru a afişa. Va apărea un grafic ca în figura de mai jos: 

 

După cum putem observa, valoarea y+ este situată între valorile 1,6 şi 1,9 (ignorând anomalia 

de la intrare). Din moment ce aceasta este mai mică decât 5, rezoluŃia grilei din zona peretelui este 

bună. 

Salvarea graficului 
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Salvăm datele din acest grafic: 

În mini-fereastra Solution XY Plot Window, selectăm Write to file (scrie în fişier). Acum 

butonul Plot este schimbat în Write (scrie). Facem clic pe Write... Introducem yplus.xy la XY File şi 

apoi OK. Verificăm dacă fişierul a fost creat în folderul de lucru.  

 

Viteza la centru  

În aceeaşi mini-fereastră, sub „Y Axis Function” vom selecta „Velocity...” şi în lista de 

dedesubt vom selecta „X Velocity”. La „Surfaces” vom selecta centerline deoarece vom afişa doar 

viteza de-a lungul axei X. Deselectăm wall.  

Facem clic pe „Curves...”. Selectăm din lista de sub „Pattern” simbolul „—”. Schimbăm 

valoarea grosimii liniei (Weight) cu valoarea 2 iar la „Symbol” lăsăm gol. Facem clic pe Apply apoi 

Close. 

 

Activăm liniile grilei: În mini-fereastra „Solution XY Plot Window”, facem clic pe „Axes...”. 

Pentru activarea grilei se selectează, din lista „Options”,  „Major Rules” şi „Minor Rules” apoi facem 

clic pe Apply. Selectăm Y la „Axis” şi facem din nou clic pe Apply, apoi Close. 
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Deselectăm „Write to File” şi apoi facem clic pe Plot pentru afişare. 

Vom genera un grafic asemănător cu cel din figura de mai jos: 

 

Putem observa că regiunea dezvoltată complet începe aproximativ de la x = 5 cu viteza la centru 

constantă la o valoare de aproximativ 1,195 m/s. Aceasta este mai mică decât valoarea de 2 m/s 

rezultată în cazul curgerii laminare. PuteŃi explica diferenŃa dintre caracteristicile fizice dintre curgerile 

laminare şi turbulente? 

Salvăm acest grafic sub denumirea de vel.xy. 

Coeficientul de frecare la limită 

DefiniŃia coeficientului de frecare la limită a fost dată în laboratorul anterior. Valorile de 

referinŃă necesare precum densitatea şi viteza au fost deja definite când s-a făcut afişarea valorii y+. 
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Deschidem din nou mini-fereastra „Solution XY Plot”. Din lista de sub „Y Axis Function” vom 

selecta „Wall Fluxes...” şi apoi „Skin Friction Coefficient”. La „Surfaces” vom selecta wall deoarece 

acolo este suprafaŃa de interes. Deselectăm centerline.   

Deselectăm „Write to File” şi facem clic pe Plot. 

   

Putem observa că valoarea zonei complet dezvoltată este de 0,0085. ComparaŃi aceasta cu ceea ce vă 

aşteptaŃi de la graficul Moody. 

Salvăm datele acestui grafic sub denumirea de cf.xy. 

Profilul de viteză 

Vom afişa viteza axială la ieşire ca o funcŃie de distanŃă de la centrul conductei. 

Schimbăm situaŃia astfel încât distanŃa radială faŃă de axă să fie afişată pe ordonată: în mini-

fereastra „Solution XY Plot” deselectăm „Position on X Axis” şi selectăm „Position on Y Axis”. La 

„Plot Direction” la X introducem valoarea 0 şi la Y valoarea 1. Pentru „X Axis Function” (abscisa), 

alegem „Velocity...” şi dedesubt „Axial Velocity”. Deoarece dorim să afişăm doar pentru zona de 

ieşire, selectăm outlet.  

Deselectăm „Write to File” şi facem clic pe Plot. 
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Vom avea următorul grafic: 

 

Viteza axială este maximă la centru şi 0 la perete pentru a satisface condiŃia de „no-slip” pentru 

curgerile vâscoase. ComparaŃi calitativ gradientul de viteză din zona de lângă perete normală la perete 

cu cel de la curgerea laminară. Care este mai mare?  După aceasta ce puteŃi spune despre forta relativa 

a contactului de lângă perete în cazul curgerii laminare şi curgerii turbulente? 

Salvăm graficul sub denumirea de profile.xy.  
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PASUL 7: CURĂłAREA MESHURILOR 

Pentru a evalua precizia numerică a rezultatelor obŃinute este necesară compararea rezultatelor 

pe diferite meshuri. Vom reface calculele pe un mesh de dimensiunea 100x60 care are numărul de 

noduri în direcŃia radială dublu decât meshul de dimensiunea 100x30. Vom recrea meshurile din 

Gambit şi îl vom salva sub denumirea de pipe100x60.msh. 

File > Read > Case… 

Din folderul de lucru vom deschide pipe100x60.msh. Facem apoi clic pe Ok, urmând în 

continuare verificarea şi verificarea grilei.  

 

Analiza meshurilor fine 

Repetăm paşii 4,5 şi 6 al acestui laborator cu meshurile curăŃate. 

Pentru a compara rezultatelor, după ce se face afişarea rezultatelor pe meshul fin, în mini-

fereastra „Solution XY Plot”, facem clic pe Load File... Intrăm în folderul de lucru, facem clic pe 

fişierul dorit (ex.: vel.xy) pentru viteza la centru, apoi OK, urmat de Plot.  Vom vedea astfel rezultatele 

pe acelaşi grafic.  
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În graficul vitezei la centru de mai sus, linia albă reprezintă viteza la centru a meshurilor fine în 

timp ce linia roşie reprezintă viteza meshurilor „brute”. După cum putem vedea, nu este o diferenŃă 

foarte mare între cele două grafice. Salvăm acest grafic sub denumirea de velt2.xy. 

În continuare ne vom ocupa de graficul coeficientului de frecare la limită. De această dată 

deschidem cft.xy pentru comparaŃie. Mai jos putem observa graficul coeficientului de frecare la limită: 

 

Din nou putem observa că nu există o diferenŃă prea mare între cele două tipuri de meshuri. 

Salvpm graficul sub denumirea de cf2.xy. Verificăm mai departe viteza de la ieşire prin afişare şi 

comparare cu graficul în fişierul outt.xy. 
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Aceeaşi observaŃie. Salvăm acest grafic sub denumirea de outt2.xy. 

În final, ne vom uita la graficul YPlus: 

 

După cum putem observa, este o creştere simŃitoare în acurateŃe la meshul fin. Salvăm acest 

grafic sub denumirea de yplus2.xy. 

Se pot face experimente cu meshuri de alte granulaŃii şi se pot compara graficele cu cele făcute 

în acest laborator. 

În problema 1 ne vom uita la efectul meshurilor brute cu granulaŃie uniformă: 
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PROBLEMA 1: 

FolosiŃi FLUENT pentru a rezolva regimul de dezvoltare într-o conductă (aceeaşi configuraŃie ca şi în 

acest laborator) în care numărul Reynolds este de 10000 pentru următoarele dimensiuni de meshuri: 

100x5, 100x20 cu spaŃiu uniform în direcŃie radială. AfişaŃi coeficientul de frecare la limită cf în funcŃie 

de locaŃia axială a fiecărei grile. ComparaŃi valorile de la ieşire cu cele presupuse pentru zona 

dezvoltată complet. Să se reamintească faptul că o întrebare cheie pentru integritatea meshului este 

valoarea adimensională a primului punct(nod). 

 
υ

⋅
ρ

τ
=

+ 1w
1

y
y  

Acesta ar trebui să fie mai mic decât 4 (astfel încât rezolvarea să fie pentru substratul vâscos) sau mai 

mare decât 30 (unde funcŃiile peretelui pot fi compensate cu precizie pentru o rezolvare slabă a 

substratului vâscos). Valorile intermediare pot duce la erori foarte mari. CalculaŃi valoarea lui +

1y  

pentru fiecare mesh; folosiŃi această valoare pentru a explica (pe scurt) concluziile trase. 
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SpecificaŃiile problemei: 

1. Crearea geometriei în GAMBIT; 

2. Mesharea geometriei în GAMBIT; 

3. Specificarea tipurilor de limite în GAMBIT; 

4. Implementarea problemei în FLUENT; 

5. Rezolvarea; 

6. Analiza rezultatelor; 

7. CurăŃirea meshurilor; 

Problema 1 

Problema 2 

 

SpecificaŃiile problemei 

 

 

 

Să se construiască o conductă cu lungimea de 75 metri şi diametrul de 10 metri prin care intră 

aer cu o viteză de 10m/s. Se introduce la o distanŃă de 25 m de la intrare o diafragmă de 

grosime 0,5 m şi diametru de 5 m. Să se reprezinte graficul presiunii şi a turbulenŃei în 

interiorul conductei ştiind că densitatea aerului este de 1,225 kg/m3 şi viscozitatea de 1,7894 • 

10-5 Kg/ms. Intensitatea turbulenŃei din interiorul conductei este de 5 %. 

 

 

Vin=10 m/s 25 

d = 10 

49,5 

75 

d = 5 
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PASUL 1: CREAREA GEOMETRIEI ÎN GAMBIT. 

Dacă dorim să sărim peste acest pas, putem crea un folder de lucru (vezi mai jos) în care să 

descărcăm meshurile (clic dreapta şi salvaŃi ca „diafragma.msh”) şi apoi puteŃi trece direct la 

pasul 4. 

 

Strategii pentru crearea geometriei. 

Conducta se poate construi prin două metode: 

• Se pot construi puncte corespunzătoare fiecărui colŃ al geometriei, separat. 

• Se pot construi puncte principale, suprapuse, pe care le vom copia de-a lungul axelor 

până la locul potrivit. 

Vom adopta cea de-a doua metodă. 

 

După ce vom construi punctele corespunzătoare tuturor colŃurilor, vom crea o faŃă care va 

conŃine suprafaŃa interioară apoi vom face mesharea ei.   

 

Crearea unui folder de lucru 

CreaŃi un folder numit „diafragma”. Vom folosi acest folder ca fiind folderul de lucru în care 

se vom păstra toate fişierele. 

 

Pornirea GAMBIT-ului 

Se iniŃializează prompterul de comenzi 

Start > Run 

 

Pentru Window NT/2000/XP: Se scrie cmd apoi se apasă OK 
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După aceasta, intraŃi în folderul de lucru. De exemplu, dacă folderul creat, numit fluent pe se 

află pe partiŃia S, executaŃi cd S:\fluent  

 

 

InterfaŃa GAMBIT arată astfel: 

- Bara meniului principal: 

 

 

 

- Meniul instrumentelor 
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Vom folosi acest meniu mai mult sau mai puŃin de-a lungul creării geometriilor. Se poate 

observa că fiecare meniu principal are sub-meniuri 

 

- Meniul de control  

 

 

Meniul de control are opŃiuni precum „Fit to Screen”  şi „Undo”  care sunt foarte 

des utilizate în timpul creării geometriei precum şi a meshurilor. 

 

- Fereastra de lucru: 

 

 

Aceasta este fereastra unde se pot observa grafic toate operaŃiile pe care le executăm. 

 

- Panoul de descriere 
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Panoul de descriere conŃine descrierile butoanelor sau obiectelor peste care mişcăm cursorul 

mouseului. Mişcând mouseul peste butoate, putem observa aceste descrieri. 

 

- Fereastra de transcriere a comenzilor 

 

 

Aceasta este fereastra în care se scriu comenzile în Gambit şi în care se pot şterge/corecta. 

Dacă la un moment-dat nu sunteŃi sigur ca nu aŃi apăsat butonul corect sau aŃi greşit comanda, 

aici se poate observa motivul. Se poate mări fereastra prin apăsarea săgeŃii din partea de sus, 

dreapta iar pentru a reveni la dimensiunile iniŃiale, se apasă din nou. 

 

Selectarea Solverului 

Main Menu > Solver > Fluent 5/6 

 

Se verifică apoi dacă s-a activat, în fereastra de transcriere a comenzilor. 

 

 

Strategii pentru crearea geometriei 

Vom plasa originea sistemului de coordonate în colŃul de jos stânga a dreptunghiului. Pentru 

a simplifica construcŃia, vom crea doar partea de sus a conductei apoi, în Fluent, o vom 

completa. Coordonatele colŃurilor sunt arătate în figura de mai jos: 
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Vom crea pentru început punctul de coordonate (0,0). 

 

ConstrucŃia punctelor (vertexurilor)  

Din meniul instrumentelor se creează urmând următorii paşi: 

Operation Toolpad > Geometry Command Button  > Vertex Command Button 

 > Create Vertex  

 

Următorul pas este introducerea coordonatelor. Vom începe prin crearea unui vertex în colŃul 

stânga jos a dreptunghiului: 

În dreptul lui x: vom introduce valoarea 0. În dreptul lui y: de asemenea 0 iar la z: tot 

valoarea 0 (din cauză că avem o problemă bidimensională). Apoi se face clic pe „Apply”. 

Aceste valori au creat vertexul care are coordonatele (0,0,0). În figura de mai jos se observă 

grafic aceste setări: 

 

În fereastra de transcriere a comenzilor, Gambit-ul ne afişează comanda de creare a 

vertexului „Created vertex: vertex.1”. Vertexurile sunt numerotate consecutiv: vertex.1, 

vertex.2 etc.; în ordinea în care au fost create. 

 

(25,5) (75,5) (0,5) 

(0,0) 

Y 

X 

(25.5,5) 

(25.5,2.5) (25,2.5) 
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În continuare vom crea punctul de coordonate (0,5). Pe care îl vom copia, împreuna cu primul 

punct, de-a lungul axei X la o distanŃă de 75 unităŃi (unităŃile de măsură se introduc cu 

ajutorul altor programe de citire a meshurilor).  

Copierea se face cu ajutorul butonului   din mini-fereastra de creare a punctelor. 

Pentru copiere/mutare, se selectează, cu ajutorul butonului „Pick”, punctele şi se selectează, 

de exemplu, pentru copiere, butonul „Copy” iar în căsuŃa de alături de câte ori se face 

copierea; la coordonate se introduc valorile axelor. Pentru cazul nostru, la numărul de copii 

punem valoarea 1 iar pentru coordonate, la X: valoarea 75 iar la Y: şi Z: valoarea 0. 

 

 

Apoi, pentru a putea încadra toate puncte în ecran, vom folosi comanda „Fit to window”. 

Operation Toolpad > Global Control > Fit to Window Button  
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Acum putem observa pe ecran toate cele patru puncte. 

 

Vom construi în continuare, prin copierea punctelor de bază, punctele care descriu diafragma 

(a nu se uita că geometria pe care o construim este una simetrică). Vom selecta primele două 

puncte şi le vom copia de-a lungul axei X la o distanŃă de 25 respectiv 25.5 unităŃi. Vom avea 

o construcŃia ca în figura de mai jos. 

 

După cu putem observa, avem nevoie ca punctele din interior, jos, să fie mutate la o distanŃă 

de 2,5 unităŃi, de-a lungul axei Y. Pentru asta, selectăm punctele cu ajutorul tastei SHIFT, din 

mini-fereastra din dreapta selectăm „Move” (Mutare) iar la axele de coordonate introducem: 

la X: şi Z: valoarea 0 iar la Y: 2.5. 

Vom avea o construcŃie ca în figura de mai jos: 

 

ConstrucŃia laturilor 

În continuare vom conecta perechi apropiate de vertexuri pentru a crea laturile:  

Operation Toolpad > Geometry Command Button  > Edge Command Button  

> Create Edge  

 

Pentru selectarea unui obiect în Gambit, se Ńine buton SHIFT de la tastatură şi apoi se 

selectează. Se pot face astfel selecta mai multe obiecte. În cazul nostru, vom selecta, pe rând, 
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vertexurile. Pe măsură ce selectăm punctele, pe ecran ele vor apărea de culoare roşie (pot 

apărea şi de altă culoare, în funcŃie de setările culorilor – standard este roşie). Făcând click pe 

săgeata în sus din meniu, o mică fereastră se va deschide. 

  

În această mini-fereastră vom observa punctele selectate. Ele pot fi mutate din stânga, unde 

sunt cele disponibile (Available) spre dreapta, unde sunt cele selectate (Picked) şi invers. 

Procesul de mutare se poate face simplu cu ajutorul săgeŃilor (---> şi <---). 

 

După ce au fost selectate vertexurile corecte, se închide mini-fereastra făcând click pe 

butonul Close apoi Apply din meniul de creare a laturilor. 

Pe ecran va apărea următoarea imagine: 

 

Se repetă aceeaşi paşi pentru crearea celorlalte laturi. 

 

ConstrucŃia feŃelor 

Operation Toolpad > Geometry Command Button  > Face Command Button  

> Form Face  

Pentru a construi o faŃă înscrisă de ceşe opt laturi trebuie să selectăm cele opt laturi care 

formează suprafaŃa. Aceasta se poate face tot cu ajutorul tastei SHIFT, selectând pe rând 

fiecare latură (putem observa că liniile selectate apar de culoare roşie). După ce s-au selectat 

cele patru laturi, se ia mâna de pe tastă. 
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Sau, mai simplu, se face clic pe săgeata în sus care deschide o alta mini-fereastră în care 

avem de această dată laturile. 

 

Iar mini-fereastra arată ca în figura de mai jos. 

 

Se trec apoi toate din stânga în dreapta prin simplu clic pe All����. Se închide apoi mini-

fereastra făcând clic pe Close apoi Apply. 
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PASUL 2: GEOMETRIA MESHURILOR ÎN GAMBIT 

Vom mesha faŃă dreptunghiului cu diviziuni de mărimea 0.1. Vom mesha direct faŃa. SpaŃiul 

dintre grile este specificat de către meshul feŃei. 

 

Mesharea feŃei 

Operation Toolpad > Mesh Command Button  > Face Command Button  > 

Mesh Face  

Se selectează faŃa, cu ajutorul săgeŃii sau tastei SHIFT după care se face clic pe Apply iar la 

„Interval Count” se trece valoarea 100 pentru o rezoluŃie bună. Pe ecran va apărea imaginea 

de mai jos. 
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PASUL 3: SPECIFICAREA TIPURILOR DE LIMITĂ 

 

Definirea tipurilor de limită 

După cum se observă şi în figura de mai sus, vom definit tipurile de limite. Astfel, latura din 

stânga va fi intrarea în conductă, latura din dreapta ieşirea, cea de sus o definim ca fiind 

perete iar cea de jos ca axa. 

Operation Toopad > Zones Command Button  > Specify Boundary Types 

Command Button  

Aceasta va deschide meniul de specificare a tipurilor de limită. Prima dată vom specifică că 

latura din dreapta este intrarea. La „Entity:” vom face clic pe Edges pentru ca Gambitul să 

ştie că vrem să selectăm o latură. 

 

Vom selecta latura din stânga după care se face clic pe Apply. Apoi, la Name: vom pune 

inlet iar la Type: vom alege VELOCITY_INLET, urmat de Apply. 

Repetăm aceiaşi paşi şi pentru celelalte laturi, respectând tabelul: 

POZIłIA LATUREI NUMELE TIPUL 

Stânga velocity_inlet.1 VELOCITY_INLET 

Dreapta pressure_outlet.2 PRESSURE_OUTLET 

Sus wall.4 WALL 

Jos axis.3 AXIS 

 

 

Axis (axa) 

Outlet 
(ieşire) 

Inlet 
(intrare) 

Wall (perete) 
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La final vom avea următoarele: 

 

 

Salvarea lucrului şi Exportul 

Main Menu > File > Save 

Main Menu > File > Export > Mesh 

Scriem diafragma.msh la File Name:, apoi selectăm Export 2d Mesh deoarece este un mesh 

bidimensional. În final, clic Accept. 

 

Verificăm dacă diafragma.msh a fost creat în folderul de lucru. 
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PASUL 4: SETAREA PROBLEMEI ÎN FLUENT 

Se deschide fluentul: 

Start > All Programs > Fluent Inc Products > Fluent x.x.xx > Fluent x.x.xx 

 

 

Selectăm 2ddp din listă apoi Run 

„2ddp” este folosit atunci când folosim un solver bidimensional, de precizie dublă. În 

solverul de precizie dublă fiecare număr este reprezentat folosind 64 biŃi, în contrast cu 

solverul de precizie simplă care foloseşte 32 biŃi. Numărul mare de biŃi creşte precizia dar şi 

ordinul de mărime care poate fi reprezentat. Dezavantajul este că pentru astfel de solver 

avem nevoie de mai multă memorie. 

 

Importul grilei 

Main Menu > File > Read > Case… 

Cazul se deschide din folderul de lucru de unde se selectează pipe.msh. Acest este fişierul 

care a fost creat de preprocesorul Gambit în pasul anterior. Fluentul expune meshurile exact 

cum sunt ele scrise în Gambit.  

 

De altfel, dacă privim la zone, avem inlet, wall, outlet  şi centerline. 
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Verificarea şi afişarea grilei 

Pentru început se verifică grila pentru a fi siguri că nu sunt erori.  

a ) Verificarea grilei se face din 

Main Menu > Grid > Check  

Orice eroare întâlnită va fi reportată imediat. Verificăm apoi ieşirea pentru a fi siguri că nici 

acolo nu avem erori. Apoi se face verificarea dimensiunii grilei: 

Main Menu > Grid > Info > Size 

Aceasta arată ca în figura de mai jos: 

  

b) Afişarea grilei se face din: 

Main Menu > Display > Grid 

Trebuie să ne asigurăm că toate suprafeŃele (Surfaces) sunt selectate. Apoi facem clic pe 

Display. O nouă fereastră în care vom observa grila se va deschide. Se va închide apoi făcând 

click pe Close. 

OperaŃiile disponibile în fereastra de grid sunt: 

- TranslaŃia: Gridul poate fi mutat în orice direcŃie, Ńinând apăsat clic stanga şi 

mişcând mouseul; 

- Mărirea: Aceasta se poate face Ńinând apăsată rotiŃa mouseului după care se mişcă 

din stânga spre dreapta. 

- Micşorarea: Aceasta se poate face Ńinând apăsată rotiŃa mouseului după care se mişcă 

din dreapta spre stânga. 

 

Mărirea grilei arată ca în figura de mai jos: 
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Putem să vizualizăm şi părŃi diferite ale geometriei alegând din lista de suprafeŃe. Se face clic 

din nou pe Display şi apoi se vizualizează părŃile selectate. De exemplu: wall, outlet şi 

centerline. 

 

Avem: 
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În cazul în care avem mai multe limite, putem să le selectăm sau să le deselectăm pe toaate 

folosind butoanele  de lângă Surfaces. 

 

Difinirea proprietăŃilor solverului 

Main Menu > Define > Models > Solver 

Vom alege Axisymmetric din lista de sub Space. Vom folosi setările prestabilite ale 

solverului segregat(................), forumare implicită, curgere staŃionară şi viteză absolută. 

La Space vom selecta Axisymmetric deoarece am construit doar partea superioară a 

conductei. 

La Time vom selecta Steady (Regim StaŃionar) deoarece nu ne interesează timpul. 

 

Main Menu > Define > Models > Viscous 

Alegem k-omega deoarece avem curgere turbulentă. La Model Constants nu se modifică 

valorile. 

 

Main Menu > Define > Models > Energy 
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Pentru fluidele incompresibile, ecuaŃia energiei este decuplată de la continuitate şi de la 

ecuaŃia momentului. EcuaŃia o vom activa numai atunci când dorim să observăm distribuŃia 

temperaturii. În exemplul nostru nu este necesar. Lăsăm deci Energy Ecuation deselectat şi 

facem clic pe Cancel pentru anulare. 

 

 

Definirea proprietăŃilor materialelor 

Main Menu > Define > Materials… 

Îi dăm valoarea densităŃii 1,225 şi a viscozităŃii 1,7894e-05. Acestea sunt valorile care sunt 

specificare în problema noastră. Le vom considera pe amândouă constante. 

 

 

Definirea condiŃiilor de operare 

Main Menu > Define > Operating Conditions 

Pentru toate curgerile, Fluentul foloseşte măsura presiunii interioare. De fiecare dată când 

este nevoie de presiunea absolută, ea este generată prin adăugarea presiunii de operare la 

presiunea măsurată. Vom folosi valoarea predefinită de 1 atm. (101,325 Pa) ca presiune de 

operare. 
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Definirea condiŃiilor la limită 

Vom stabili în continuare valoarea vitezei la intrare şi a presiunii la ieşire. 

Main Menu > Define > Boundary Conditions… 

Aducem aminte că cele tipuri de limite pe care le-am definit sunt specificate ca zone în partea 

de stângă a ferestrei condiŃiilor la limită. Zona axis.3 ar trebui să fie selectată automat. În 

cazul în care nu este, trebuie să ne asigurăm că tipul acestei limite este axă (axis din lista). 

Apoi se face clic pe Set. Observăm că nu este nici o setare de făcut decât numele pe care, în 

cazul nostru, îl vom lăsa axis.3.  

Apoi, mai jos, în listă selectăm velocity_inlet.1. Observăm că Fluent-ul indică că tipul acestei 

limite este velocity-inlet. Ne amintim că aceasta a fost deja stabilită în Gambit. Dacă este 

necesar, putem schimba tipul limitei stabilită anterior în Gambit în acest meniu prin 

selectarea diferitelor tipuri din dreapta. 

  

Facem clic pe velocity_inlet.1 apoi Set...  Se va deschide o nouă mini-fereastră. Vom adăuga 

valoarea 10 la Velocity Magnitude (mărimea vitezei). Aceasta setează viteza cu care fluidul 

intră în conductă prin limita din stânga. Deoarece am selectat la Solver, turbulenŃă de tip k-

omega, în continuare vom stabili Intensitatea turbulenŃei şi diametrul hydraulic. 

La Turbulent Intensity (intensitatea turbulenŃei) vom avea valoarea 5 iar la Hydraulic 

Diametric valoarea 0,1. 
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Presiunea (absolută) la ieşire este de 1 atm. Din moment ce presiunea de operare este stabilită 

ca fiind 1atm, mărimea presiunii la ieşire = presiunea absolută la ieşire – presiunea de operare 

= 0.  

 

Apăsăm apoi OK pentru a reveni la lista limitelor. 

 

Alegem din listă pressure_outlet.2. Tipul acestei limite este pressure-outlet. Facem clic pe 

Set... Valoarea prestabilită a Gauge Pressure (mărirea presiunii) este 0. La Backflow 

Turbulent Intesity introducem valoarea 5 iar la Backflow Hydraulic Diameter valoarea 

0,1. 

 

În final selectăm wall şi ne asigurăm că tipul acestei limite este tot wall (perete). Facem clic 

pe fiecare buton unde avem: Momentum, Thermal, Radiation, Species etc. şi vom observa că 

numai la Momentul putem schimba în urma condiŃiilor stabilite până acum.  

Închidem meniul Boundary Contitions. 
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PASUL 5: REZOLVAREA 

Vom folosi o schemă de discretizare de ordinul doi. 

Main Menu > Solve > Controls > Solution… 

La Pressure-Velocity Coupling vom selecta din lista Coupled. Iar la Courant Number 

avem valoarea 10. 

La Density şi Body Forces vom avea valoarea 1. 

La Turbulent Kinetic Energy şi Specific Dissipation Rate valoarea 0,8; 

 

 

Se face prima presupunere 

Se iniŃializează câmpul curgerii cu valorile de la intrare: 

 Main Menu > Solve > Initialize… 

În meniul Solution Initialization la Compute From vom alege inlet. Viteza axială (Axial 

Velocity) pentru toate celulele va fi setată la 10 m/s, viteza radială (Radial Velocity) va fi 0 

m/s. Aceste valori au fost luate de la condiŃiile limită la intrare. 

 

Facem clic pe Init pentru a iniŃializa, apoi Apply şi, în final, Close. 
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Setarea crierului ce convergenŃă 

Fluentul face raportul la reziduul pentru fiecare ecuaŃie ce urmează a fi rezolvată. Reziduul 

este măsura la cât de mult satisface soluŃia curentă forma discretizantă a fiecărei ecuaŃii ce 

guvernează. Vom itera soluŃia până când reziduul fiecărei ecuaŃii scade sub 1 · 10-6. 

Main Menu > Solve > Monitors > Residual… 

Schimbăm reziduul pentru continuity, x-velocity şi y-velocity, toate cu valoarea 1e-6. După 

aceasta, pentru vizualizare, se face clic pe Plot. Acesta va face graficul reziduurilor în 

fereastra grafică după cum sunt ele calculate. 

 

Dacă vă apar erori de tipul “Error: FLUENT received a fatal signal (SEGMENTATION 

VIOLATION)” sau „Error: floating point error: divide by zero” înseamnă că placa video 

este configurată pentru funcŃionarea calculatorului cu viteză şi nu pentru performanŃă. 

ConsultaŃi un expert pentru soluŃionarea unei astfel de probleme. 

 

Am terminat specificaŃiile problemei. Salvăm totul: 

Main Menu > File > Write > Case… 

Salvăm cu numele diafragma.cas pentru fişierele de tip case. Verificăm apoi dacă s-a salvat 

în folderul de lucru. Dacă închidem Fluent-ul acum, putem continua cu tot ceea ce am stabilit 

până acum. 

 

Iterare până la convergenŃă 

Vom porni calcularea făcând 100 de iteraŃii: 

Main Menu > Solve > Iterate 



Laborator 3. Curgerea unui fluid printr-o conductă prevăzută cu diafragmă 

 23 

În fereastra de iteraŃii (Iterate Window) schimbăm numărul de iteraŃii (Number of 

Iterations) de la 1 la 200 apoi facem click pe Iterate. 

 

 

Reziduurile pentru fiecare iteraŃie sunt afişate şi listate în fereastra de grafice după cum sunt 

ele calculate. 

 

Reziduurile ajung la criteriul de convergenŃă specificat (1 · 10-6) la 46 de iteraŃii. 

 

Pentru a vizualiza şi partea axiometrică, vom selecta din meniul  

Display > Views iar la planele de oglindire (Mirror Planes) selectăm axis.3 pe care am 

definit-o în GAMBIT 

 

 

 

Se salvează soluŃia ca un fişier dată: 
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Main Menu > File > Write > Data… 

Introducem la nume pipe.dat. Din nou, se verifică dacă fişierul a fost salvat în folderul de 

lucru. Din acest moment se pot determina soluŃiile de fiecare dată folosind acest fişier. 
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PASUL 6: PROFILUL DE PRESIUNE 

La meniul Display, alegem Contours, pentru a avea o imagine mai bună asupra profilului de 

presiune. 

În mini-fereastra care se deschide, selectăm suprafeŃele pe care dorim sa vedem acest profil.  

La „Contours of” alegem pe rând, Pressure apoi Turbulence. În casuŃa de sub Pressure vom 

selecta Dynamic Pressure iar la Turbulence, Turbulence Intensity. 

 

Facem clic apoi pe Plot. 

Aceasta generează graficul vitezei axiale ca o funcŃie de distanŃă de-a lungul axei centrale a 

conductei. 

La Pressure vom avea un profil ca în figura de mai jos: 
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La Turbulence Intensity va genera un profil asemănător figurii de mai jos: 

 



 

 

 

 

 

 

AMESTECUL FLUIDELOR ÎN 

CONDUCTE TIP “COT” 
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SpecificaŃiile problemei: 

1. Crearea geometriei în GAMBIT; 

2. Mesharea geometriei în GAMBIT; 

3. Specificarea tipurilor de limite în GAMBIT; 

4. Implementarea problemei în FLUENT; 

5. Rezolvarea; 

6. Analiza rezultatelor; 

7. CurăŃirea meshurilor; 

Problema 1 

Problema 2 

 

SpecificaŃiile problemei 

 

 

 Se consideră un fluid rece (26 ˚C) care intră prin partea stângă a profilului de Ńeavă tip 

„cot” prezentat în figura de mai sus şi care se amestecă cu fluid cald (40 ˚C) în dreptul 

cotului. Dimensiunile Ńevii sunt date în inch iar proprietatea fluidului împreună cu condiŃiile 

la limită sunt date în unităŃi din SI. Numărul lui Reynolds la intrarea în Ńeavă este de 2,03 x 

105, având, deci, nevoie de un model de turbulenŃă. Se mai dau şi următorii parametri: 

- Densitatea, ρ = 1000 kg/m3; 

- Viscozitatea, µ = 8 x 104 kg/m·s; 
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- Conductivitatea termică, k = 0,677 W/m·K; 

- Căldura specifică, Cp = 4216 J/Kg ·˚C. 

 

RezolvaŃi această problemă folosind programul de simulare FLUENT.  
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PASUL 1: CREAREA GEOMETRIEI ÎN GAMBIT. 

 

Dacă dorim să sărim peste acest pas, putem crea un folder de lucru (vezi mai jos) în care să 

descărcăm meshurile (clic dreapta şi salvaŃi ca „tcot.msh”) şi apoi trece direct la pasul 4. 

 

Crearea unui folder de lucru 

CreaŃi un folder numit „tcot”. Vom folosi acest folder ca fiind folderul de lucru în care se 

vom păstra toate fişierele. 

 

Pornirea GAMBIT-ului 

Se iniŃializează prompterul de comenzi 

Start > Run 

 

Pentru Window NT/2000/XP: Se scrie cmd apoi se apasă OK 

 

 

După aceasta, intraŃi în folderul de lucru. De exemplu, dacă folderul creat, numit fluent pe 

partiŃia S: în Windows, executaŃi cd S:\fluent  

 

 

InterfaŃa GAMBIT arată astfel: 

- Bara meniului principal: 
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- Meniul instrumentelor 

 

Vom folosi acest meniu mai mult sau mai puŃin de-a lungul creării geometriilor. Se poate 

observa că fiecare meniu principal are sub-meniuri. 

 

- Meniul de control  

 

Meniul de control are opŃiuni precum „Fit to Screen”  şi „Undo”  care sunt foarte 

des utilizate în timpul creării geometriei precum şi a meshurilor. 

 

- Fereastra de lucru: 
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Aceasta este fereastra unde se pot observa grafic toate operaŃiile pe care le executăm. 

 

- Panoul de descriere 

 

Panoul de descriere conŃine descrierile butoanelor sau obiectelor peste care mişcăm cursorul 

mouseului. Mişcând mouseul peste butoate, putem observa aceste descrieri. 

 

- Fereastra de transcriere a comenzilor 

 

Aceasta este fereastra în care se scriu comenzile în Gambit şi în care se pot şterge/corecta. 

Dacă nu suntem siguri ca am apăsat butonul corect sau am greşit comanda, aici se poate 

monitoriza. Se poate mări fereastra prin apăsarea săgeŃii din partea de sus, dreapta iar pentru 

a reveni la dimensiunile iniŃiale, se apasă din nou. 

 

Selectarea Solverului 

Main Menu > Solver > Fluent 5/6 
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Se verifică apoi dacă s-a activat, în fereastra de transcriere a comenzilor. 

 

 

ConstrucŃia punctelor (vertexurilor)  

Pentru început vom afişa grila pe care vom construi punctele din: 

TOOLS  > COORDINATE SYSTEM  > DISPLAY GRID  

Se va deschide o mini-fereastră în care vom introduce limitele distanŃei dintre ochiurile de 

reŃea, astfel: la valoarea minimă vom introduce valoarea -32 iar la maximă 32. Incrementul de 

multiplicare va fi de 16. La Plane (planul de vizualizare) vom bifa XY (2D) iar la axis, Y. 
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Vom avea o imagine asemănătoare cu cea din figura de mai jos: 

 

 

Pentru a putea încadra toată geometria pe ecran, vom folosi comanda „Fit to window”. 

Operation Toolpad > Global Control > Fit to Window Button  

 

 

Vom construi puncte pe punctele de intersecŃie ale ochiurilor de reŃea, după ordinea 

prezentată în figura de mai jos: 
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Pentru a construi aceste puncte, eliminând etapa costisitoare de a le crea folosind 

coordonatele fiecăruia, vom selecta nodurile de la intersecŃia ochiurilor cu ajutorul tastei 

CTRL şi CLIC DREAPTA pe fiecare. 

După ce am construit cele nouă puncte, vom dezactiva ochiurile de reŃea. Din: 

TOOLS  > COORDINATE SYSTEM  > DISPLAY GRID , în mini-

fereastra care se va deschide, dezactivăm Visibility apoi facem clic pe Apply. 

Vom avea următoarea figură: 

 

A B 

C D 

E F G 

H I 
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ConstrucŃia laturilor 

Pentru început vom crea arcul de cerc de la cot. 

Operation Toolpad > Geometry Command Button  > Edge Command Button 

 > Create Edge  

Se va deschide o mini-fereastră  în care avem două metode de a crea arcul de cerc. Pentru 

geometria noastră vom alege prima variantă deoarece avem centrul lui. La center vom selecta 

punctul E iar la End-Points (punctele extreme), întâi D şi F pentru cercul mic, apoi punctele 

B şi G pentru cel mare. 

 

Vom avea: 

 

Construim în continuare laturile: 
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Operation Toolpad > Geometry Command Button  > Edge Command Button 

 > Create Edge  

 

Pentru selectarea unui obiect în Gambit, se Ńine buton SHIFT de la tastatură şi apoi se 

selectează. Se pot face astfel selecta mai multe obiecte. În cazul nostru, vom selecta, pe rând, 

vertexurile. Pe măsură ce selectăm vertexurile, pe ecran ele vor apărea de culoare roşie (pot 

apărea şi de altă culoare, în funcŃie de setările culorilor – standard este roşie). Făcând clic pe 

săgeata în sus din meniu, o mică fereastră se va deschide. 

  

În această mini-fereastră vom observa vertexurile selectate. Ele pot fi mutate din stânga, unde 

sunt cele disponibile (Available) spre dreapta, unde sunt cele selectate (Picked) şi invers. 

Procesul de mutare se poate face simplu cu ajutorul săgeŃilor (---> şi <---). 

După ce au fost selectate vertexurile corecte, se închide mini-fereastra făcând clic pe butonul 

Close apoi Apply din meniul de creare a laturilor. 

Pe ecran va apărea următoarea imagine: 

 

 

Vom construi apoi canalul mic pe unde vom introduce fluidul cald. Pentru asta selectăm: 

Operation Toolpad > Geometry Command Button  > Edge Command Button 

 > Split/Merge Edges  
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Vom selecta pentru început arcul cel mare. La tipul laturii vom selecta Real, la Split with 

(împarte prin) vom selecta Point iar la tipul sistemului de coordonate vom avea Cylindrical. 

Apoi, mai jos, la valorile locale vom introduce, pe rând, la t (unghiul de la centru) valoarile 

39.93, respectiv 50,07 (pentru arcul din partea de jos). 

 

Vom avea următoarea figură: 

 

Vom selecta punctul creat în partea de jos a arcului după care îl vom copia de-a lungul axei Y 

cu 12 unităŃi (după cum putem observa şi în desenul de prezentare a problemei). Pentru 

copiere selectăm: 
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Operation Toolpad > Geometry Command Button  > Vertex Command Button 

 > Move/Copy/Align Vertices  

În mini-fereastra care apare vom selecta Copy iar în căsuŃa de alături, unde vine introdus 

numărul de multiplicări, vom introduce valoarea 1. La operaŃii vom selecta Translate iar la Y 

vom introduce valoarea -12. 

 

Punctul recent creat îl vom copia de-a lungul axei X la o lungime de 4 unităŃi. 

Vom avea următoarea geometrie: 
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Vom construi apoi laturile care leagă toate cele patru puncte şi vom avea o geometrie ca cea 

prezentată în figura de mai jos: 

 

ConstrucŃia feŃelor 

Operation Toolpad > Geometry Command Button  > Face Command Button  

> Form Face  

Pentru a construi o faŃă înscrisă de patru laturi trebuie să selectăm cele patru laturi care 

formează suprafaŃa. Aceasta se poate face tot cu ajutorul tastei SHIFT, selectând pe rând 

fiecare latură (putem observa că liniile selectate apar de culoare roşie). După ce s-au selectat 

cele patru laturi, se ia mâna de pe tastă. 

Sau, mai simplu, se face clic pe săgeata în sus care deschide o alta mini-fereastră în care 

avem de această dată laturile. 

 

Iar mini-fereastra arată ca în figura de mai jos. 
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Vom construi întâi faŃa cilindrului cot. Pentru asta selectăm doar laturile corespunzătoare lui, 

incluzând şi micul arc de cerc creat în urma împărŃirii arcului mare. Construim apoi faŃa 

cilindrului mic selectând cele patru laturi care îl compun. 
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PASUL 2: GEOMETRIA MESHURILOR ÎN GAMBIT 

 

Mesharea laturilor 

Operation Toolpad > Mesh Command Button  > Edge Command Button  > 

Mesh Edges  

Din nou selectăm cu ajutorul tastei SHIFT sau din meniu laturile corespunzătoare intrării şi 

ieşirii din conductă. Dacă în fereastra grafică nu se observă bine aceste linii, putem mări 

Ńinând apăsată tasta CTRL apoi click pe zona pe care vrem să o mărim. Dacă s-a mărit prea 

mult, se poate reveni folosind „Fit to Window”. 

Vom selecta laturile corespunzătoare intrării şi ieşirii din Ńeavă apoi, în fereastra din dreapta, 

Double sided (ambele părŃi) şi vom introduce la Ratio (Rata) valoarea 1,25 iar la Spacing, în 

căsuŃa intervalelor, vom selecta Interval Count unde vom introduce valoarea 10. 

Vom avea o imagine asemănătoare cu cea de jos: 

 

 

Se repetă acelaşi algoritm şi pentru mesharea laturilor orizontale, dar divizat în 100 de unităŃi. 

După ce am meshuit laturile putem crea meshuirea bidimensională a feŃei. 

În continuare vom mesha laturile drepte. Vom selecta feŃele; la Ratio vom avea valoarea 1  

iar la Interval Count vom introduce valoarea 15 (numărul de intervale). 

Facem clic pe Apply. 

Vom avea: 
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Vom mesha apoi arcul de cerc aflat la intersecŃia celor două conducte. Vom proceda la fel ca 

şi mai sus având: 

- la Ratio vom avea valoarea 1; 

- la Interval Count vom avea 6. 

Vom obŃine: 

 

În continuare vom mesha arcele de cerc din stânga şi dreapta arcului de intersecŃie.  

- selectăm arcul din stânga şi ne asigurăm că săgeata roşie va fi îndreptată spre Ńeava 

mică (în cazul în care nu o observăm vom mări zona) şi introducem la Ratio valoarea 

0,9 iar la Interval Count valoarea 12. Facem clic pe Apply şi vom putea vizualiza 

meshul. 

- selectăm arcul din dreapta şi urmăm acelaşi procedeu, din nou, asigurându-ne că 

săgeata roşie este îndreptată în jos, spre Ńeava mică. 
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Vom avea: 

 

Meshăm acum arcul mic de cerc procedând la fel ca şi la laturile corespunzătoare intrării şi 

ieşirii din conductă şi anume: selectăm arcul, la Ratio introducem 0,85 şi selectăm Double 

sided, lăsîng GAMBIT-ul să calculeze singur spaŃiul de intervale. Pentru ca programul nostru 

să calculeze singur numărul de intervale vom deselecta Apply de la Spacing. Deselectăm, de 

altfel, şi butonul Mesh de la Options. Vom avea o figură asemănătoare celei de sus. 

 

Mesharea feŃei 

Operation Toolpad > Mesh Command Button  > Face Command Button  > 

Mesh Face  

Selectăm faŃa corespunzătoare conductei mari apoi facem clic pe Apply. Vom avea: 
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În final, vom mesha Ńeava mică. Vom selecta faŃa după care îi vom aplica meshul. La 

Elements vom avea Quad, la Type vom avea Map iar la Interval Spacing valoarea 1. 

Vom obŃine geometria finală: 
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PASUL 3: SPECIFICAREA TIPURILOR DE LIMITĂ 

 

 

Definirea tipurilor de limită 

Pentru început vom dezactiva grafic meshurile pentru a putea observa mai bine fiecare latură. 

Pentru asta facem clic pe butonul  din partea dreapta jos. În mini-fereastra care se va 

deschide vom selecta Off în dreptul Mesh-ului apoi clic pe Apply. Vom observa că pe ecran 

va dispărea meshul. 

 

Din: 
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Operation Toopad > Zones Command Button  > Specify Boundary Types 

Command Button  

vom defini tipurile de limite. Pentru întrări vom aloca tipul de limită numit Velocity Inlet iar 

pentru ieşire Pressure Outlet 

 

 

Salvarea lucrului şi Exportul 

Main Menu > File > Save 

Main Menu > File > Export > Mesh 

Scriem pipe.msh la File Name:, apoi selectăm Export 2d Mesh deoarece este un mesh 

bidimensional. În final, clic Accept. 

 

Verificăm dacă tcot.msh a fost creat în folderul de lucru. 
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PASUL 4: SETAREA PROBLEMEI ÎN FLUENT 

Se deschide fluentul: 

Start > All Programs > Fluent Inc Products > Fluent x.x.xx > Fluent x.x.xx 

 

 

Selectăm 2ddp din listă apoi Run 

„2ddp” este folosit atunci când folosim un solver bidimensional, de precizie dublă. În 

solverul de precizie dublă fiecare număr este reprezentat folosind 64 biŃi, în contrast cu 

solverul de precizie simplă care foloseşte 32 biŃi. Numărul mare de biŃi creşte precizia dar şi 

ordinul de mărime care poate fi reprezentat. Dezavantajul este că pentru astfel de solver 

avem nevoie de mai multă memorie. 

 

Importul grilei 

Main Menu > File > Read > Case… 

Cazul se deschide din folderul de lucru de unde se selectează pipe.msh. Acest este fişierul 

care a fost creat de preprocesorul Gambit în pasul anterior. Fluentul expune meshurile exact 

cum sunt ele scrise în Gambit.  
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Verificarea şi afişarea grilei 

Pentru început se verifică grila pentru a fi siguri că nu sunt erori.  

a ) Verificarea grilei se face din 

Main Menu > Grid > Check  

Orice eroare întâlnită va fi reportată imediat. Verificăm apoi ieşirea pentru a fi siguri că nici 

acolo nu avem erori. Apoi se face verificarea dimensiunii grilei: 

Main Menu > Grid > Smooth/Swap 

Se foloseşte pentru a oferi calculelor o calitate mai bună. Facem clic apoi pe Smooth. 

 

Main Menu > Grid > Scale 

Schimbam valoarea unităŃilor în INCH după care îi dăm Scale. 

 

 

b) Afişarea grilei se face din: 

Main Menu > Display > Grid 

Trebuie să ne asigurăm că toate suprafeŃele (Surfaces) sunt selectate. Apoi facem clic pe 

Display. O nouă fereastră în care vom observa grila se va deschide. Se va închide apoi făcând 

click pe Close. 

OperaŃiile disponibile în fereastra de grid sunt: 

- TranslaŃia: Gridul poate fi mutat în orice direcŃie, Ńinând apăsat clic stanga şi 

mişcând mouseul; 

- Mărirea: Aceasta se poate face Ńinând apăsată rotiŃa mouseului după care se mişcă 

din stânga spre dreapta. 
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- Micşorarea: Aceasta se poate face Ńinând apăsată rotiŃa mouseului după care se mişcă 

din dreapta spre stânga. 

Grila arată ca în figura de mai jos: 

 

Putem să vizualizăm şi anumite părŃi ale grilei alegând din lista de suprafeŃe. Se face clic din 

nou pe Display şi apoi se vizualizează părŃile selectate.  

În cazul în care avem mai multe limite, putem să le selectăm sau să le deselectăm pe 

toaate folosind butoanele  de lângă Surfaces. 

 

Difinirea proprietăŃilor solverului 

Main Menu > Define > Models > Solver 

Vom folosi setările prestabilite ale solverului segregat, formulare implicită, curgere staŃionară 

şi viteză absolută. 
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Main Menu > Define > Models > Viscous 

Vom alege, după cum am văzut la început, un regim turbulent. Ca şi în celelalte 

probleme, alegem tipul de turbulenŃă k-epsilon. Vom lăsa constantele prestabilite de acest 

model. 

 

 

Main Menu > Define > Models > Energy 

Deoarece problema noastră implică transfer de căldură, vom activa ecuaŃia energiei. 

 

 

Definirea proprietăŃilor materialelor 

Main Menu > Define > Materials… 

Vom introduce proprietăŃile fluidului (care este apa) în fiecare căsuŃă, proprietăŃi care 

sunt date la specificaŃiile problemei. Facem clic apoi pe Change/Create.  
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Definirea condiŃiilor de operare 

Main Menu > Define > Operating Conditions 

Pentru toate curgerile, Fluentul foloseşte măsura presiunii interioare. De fiecare dată 

când este nevoie de presiunea absolută, ea este generată prin adăugarea presiunii de operare la 

presiunea măsurată. Vom folosi valoarea predefinită de 1 atm. (101,325 Pa) ca presiune de 

operare. 

 

 

Definirea condiŃiilor la limită 

Vom stabili în continuare valoarea vitezelor la intrare şi a presiunii la ieşire. 

Main Menu > Define > Boundary Conditions… 
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Selectăm fluid apoi facem clic pe Set... 

În fereastra care se va deschide vom introduce la Material Name - apa. 

 

La intrare mare vom selecta, din dreapta, velocity-inlet şi facem clic pe Set... 

În fereastra care se va deschide vom introduce: 

- la Momentum, în dreptul metodei de definire a vitezei (Velocity Specification 

Method) vom alege Components (componentele vitezei). Vom introduce mai jos 

viteza de-a lungul axei X (orizontală) care are valoarea 0.2 m/s iar la turbulenŃă, mai 

jos, vom selecta Intensity and Hydraulic Diameter unde vom introduce Intensitatea 

TurbulenŃei – 5% - şi diametrul hidraulic de 32 inch. 

- La Thermal, la Temperature vom introduce valoarea 293 K. 

 

Diametrul hidraulic se calculează cu formula: 

 Dh = 
4 · A
 Pw

   

Unde: A – aria secŃiunii şi Pw – perimetrul zonei umectate 
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Vom proceda la fel şi pentru cealaltă intrare (intraremică). Singurii parametri care vor diferi 

vor fi: viteza verticală (de-a lungul axei Y), care are valoarea de 1, diametrul hidraulic care 

are valoarea de 8 inch şi temperatura de 313K. 



Laborator 4. Amestecul fluidelor în conducte tip „cot” 

 28 

PASUL 5: REZOLVAREA 

 

Se face prima presupunere 

Se iniŃializează câmpul curgerii cu valorile de la intrare: 

Main Menu > Solve > Initialize… 

În meniul Solution Initialization la Compute From vom alege intraremare. Viteza 

orizontală şi verticală pentru toate celulele va fi setată la 0,2 m/s. Aceste valori au fost luate 

de la condiŃiile limită la intrare. 

 

Facem clic pe Init pentru a iniŃializa, apoi Apply şi, în final, Close. 

 

Setarea crierului ce convergenŃă 

Fluentul face raportul la reziduul pentru fiecare ecuaŃie ce urmează a fi rezolvată. 

Reziduul este măsura la cât de mult satisface soluŃia curentă forma discretizantă a fiecărei 

ecuaŃii ce guvernează. Vom itera soluŃia până când reziduul fiecărei ecuaŃii scade sub 1 · 10-3. 

Main Menu > Solve > Monitors > Residual… 

Schimbăm reziduul pentru continuity, x-velocity şi y-velocity, toate cu valoarea 1e-

3. După aceasta, pentru vizualizare, se face clic pe Plot. Acesta va face graficul reziduurilor 

în fereastra grafică după cum sunt ele calculate. 
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Dacă vă apar erori de tipul “Error: FLUENT received a fatal signal 

(SEGMENTATION VIOLATION)” sau „Error: floating point error: divide by zero” 

înseamnă că placa video este configurată pentru funcŃionarea calculatorului cu viteză şi nu 

pentru performanŃă. ConsultaŃi un expert pentru soluŃionarea unei astfel de probleme. 

 
Main Menu > Solve > Monitors > Surfaces 
Vom bifa la monitor-1 Plot şi Write apoi definim suprafeŃele cu ajutorul butonului Define...  

 

Aici vom selecta la Report of, Temperature şi apoi Static Temperature iar la Report 

Type selectăm Mass-Weighted Average. La Surfaces vom selecta ieşirea. 
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Am terminat specificaŃiile problemei. Salvăm totul: 

Main Menu > File > Write > Case… 

Salvăm cu numele tcot.cas pentru fişierele de tip case. Verificăm apoi dacă s-a salvat în 

folderul de lucru. Dacă închidem Fluent-ul acum, putem continua cu tot ceea ce am stabilit 

până acum. 

 

Iterăm până la convergenŃă 

Vom porni calcularea făcând 100 de iteraŃii: 

Main Menu > Solve > Iterate 

În fereastra de iteraŃii (Iterate Window) schimbăm numărul de iteraŃii de la 1 la 100 

apoi facem click pe Iterate. 

Reziduurile pentru fiecare iteraŃie sunt afişate şi listate în fereastra de grafice după 

cum sunt ele calculate. 

 

Iar la Surfaces: 
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Reziduurile ajung la criteriul de convergenŃă specificat (1 · 10-6) la 42 de iteraŃii. Asta 

înseamnă că după acest număr de iteraŃii nu se mai schimbă nimic, deci rezolvarea problemei 

este finalizată. 

  iter     time/iter 

!  42 solution is converged 

Pentru a verifica masa totală, momentul, energia şi bilanŃul scalar mergem în: 

Main Menu > Report > Fluxes 

 

După ce am selectat limitele, facem clic pe Compute (Calcul) iar în dreapta sau în fereastra 

principală va apărea rezultatul. 

 

Se salvează soluŃia ca un fişier dată: 

Main Menu > File > Write > Data… 

Introducem la nume tcot.dat. Din nou, se verifică dacă fişierul a fost salvat în folderul de 

lucru. Din acest moment se pot determina soluŃiile de fiecare dată folosind acest fişier. 
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PASUL 6: GENERAREA GRAFICELOR ŞI INTERPRETAREA 

REZULTATELOR 

Pentru început vom afişa conturul plin al conductei, pentru viteza interioară. 

Din: 

Main Menu > Display > Contours  

selectăm Velocity şi Veclocity Magnitude apoi facem clic pe Display. 

 

Vom avea o imagine ca în figura de mai jos: 

 

 

Afişăm mai apoi profilul temperaturii: 
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Afişăm, pentru o imagine mai clară, vectorii vitezei: 

Din: Main Menu > Display > Vectors 

 

Selectăm la Vectors of, Velocity. 

Avem următorul profil: 
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Pentru o imagine şi mai clară, la Scale vom introduce valoarea 3.  

Avem următorul profil: 

 

Putem să mărim zonele făcând clic pe rotiŃa mouseului. 

 



Laborator 4. Amestecul fluidelor în conducte tip „cot” 

 35 

Pentru a observa un profil din care se pot trage concluzii apropiate de realitate, vom 

afişa un grafic XY unde vom introduce diverse profiluri pe direcŃia conductei.  

1. Vom genera un grafic care urmăreşte temperatura statică la ieşirea din conductă. 

Din: 

Main Menu > Plot > XY Plot 

selectăm pe ordonată (Y) temperatura statică iar pe abscisă (X) lăsăm direcŃia iar la Surfaces 

selectăm iesire. Apoi facem clic pe Plot. 

 

Se va afişa următorul grafic: 

 

2. Vom genera un grafic după o funcŃie pe care o vom defini noi. Vom defini, de 

exemplu Densitatea de Vârf care are următoarea formulă: 

DV = 
ρ · |V|2

2   

Pentru a defini o nouă funcŃie, mergem în: 
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Main Menu > Define > Custom Field Function 

 

Pentru a scrie o formulă la Definition selectăm din dreapta ceea ce dorim să introducem în ea 

iar cu ajutorul operaŃiilor din stânga o definim ca formulă. 

Pentru formula noastră am introdus Static Density şi Velocity Magnitude (density şi |V|). 

După ce suntem siguri ca formula este cea dorită, facem clic pe Define apoi Close. 

Vom afişa acum conturul piesei în funcŃie de noua funcŃie definită. Pentru asta mergem în 

Main Menu > Display > Contours  

unde vom selecta noua funcŃie, la Custom Field Functions... 

 

Vom avea: 
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Se salvează soluŃia, din nou, ca un fişier dată: 

Main Menu > File > Write > Data… 

Introducem la nume tcot.dat şi vom scrie peste cel vechi. 

 

Până acum discretizarea a fost de gradul întâi. În continuare vom rezolva problema folosind 

discretizarea de gradul II. Pentru asta definim întâi solverul din: 

Main Menu > Define > Models > Solver 

schimbând la Gradient Option, în loc de modelul Green-Gauss Cell Based, modelul 

Green-Gauss Node Based (a se citi în curs mai multe despre ele). Facem clic apoi pe Ok. 

 

Iar acum definirea propriu-zisă a discretizării de gradul II, din 

Main Menu > Solve > Controls > Solution 
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unde vom introduce, la Momentum, Turbulent Kinetic Energy, Turbulent Dissipation 

Rate şi Energy soluŃia de discretizare Second Order Upwind. Vom da lista mai jos cu 

ajutorul săgeŃii de scroll din dreapta de unde vom schimba şi Energy. Facem apoi clic pe Ok. 

 

 

Vom face încă 100 de iteraŃii şi vom obŃine un profil cu o precizie mai mare: 

 



 

 

 

 

 

CONVECłIE FORłATĂ DE-A 

LUNGUL UNEI PLĂCI 
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SpecificaŃiile problemei: 

1. Crearea geometriei în GAMBIT; 

2. Mesharea geometriei în GAMBIT; 

3. Specificarea tipurilor de limite în GAMBIT; 

4. Implementarea problemei în FLUENT; 

5. Rezolvarea; 

6. Analiza rezultatelor; 

7. CurăŃirea meshurilor; 

Problema 1 

Problema 2 

 

SpecificaŃiile problemei 

 

 

 

Se consideră o placă de lăŃime infinită ce se află la temperatura de 150 °C. Profilul de 

viteză a fluidului este uniform la distanŃa x = 0. Temperatura fluidului care trece deasupra ei 

ei se află la temperatur de 80 °C. Ipoteza de incompresibilitate devine invalidă pentru 

diferenŃe mari de temperatură dintre placă şi fluid. Din cauza asta, vom trata curgerea ca fiind 

compresibilă. Vom analiza o curgere în următoarele condiŃii: 

ReL = 1,5e6  Pr = 0,71 

Pentru a obŃine aceste condiŃii de curgere vom folosi următoarele: 

 U∞ = 1 m/s; 

 µ = 6,667e-7 Kg/m·s; 

 k = 9,4505e-4 W/m·K; 

 Cp = 1006,43 J/Kg·K; 

 T∞ = 80 K; 

 P∞ = 101325 Pa 

U∞ 

L=1m 

Tp=140 °C 
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łinând cont de legea gazului ideal, temperatura şi presiunea rezultă din următoarea formulă a 

densităŃii: 

ρ∞ = 
P∞

RT∞
 = 

10132Pa

287
J

Kg·K·353K
  

Aceste condiŃii de curgere nu reprezintă un fluid real ci sunt alese pentru a furniza constantele 

Prandtl şi Reynolds specificate mai sus. 

RezolvaŃi această problemă folosind programul de simulare FLUENT. ValidaŃi soluŃia 

prin afişarea valorii y+ pe placă. AfişaŃi apoi, pe rând, profilul de viteză la distanŃa x = 1m şi 

dependenŃa dintre valoarile Nusselt şi Reynolds. ComparaŃi rezultatel obŃinute folosind 

Fluent şi corelaŃiile empirice. 

 

Analiza preliminară 

Ne aşteptăm la o creştere a stratului limită corespunzător turbulenŃei de-a lungul 

plăcii. Odată cu creşterea grosimii stratului, rata transferului de căldură (q’’) şi implicit 

coeficentul termic (λ) vor descreşte. 

q’’x = λx (Tplacă - T∞) 

 

Vom compara rezultatele numerice cu corelaŃiile transferului termic derivate 

experimental. Vom crea geometria pe care o vom mesha în Gambit, o vom citi cu ajutorul 

programului Fluent, apoi vom rezolva problema. 

 

U∞ 

L=1m 

Tp=140 °C 
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PASUL 1: CREAREA GEOMETRIEI ÎN GAMBIT. 

 

Strategii pentru crearea geometriei. 

Pentru a crea geometria pentru câmpul de curgere trebuie să considerăm modelul necesar 

pentru a crea o curgere aproximativ reală. Un strat limită creşte de-a lungul plăcii care trebuie 

să satisfacă condiŃia de „anti alunecare”. Viteza curgerii la nivelul plăcii trebuie să fie 0. 

Avem nevoie de continuitate pentru ca această condiŃie să genereze viteză normală (de-a 

lungul axei Y). Deşi viteza normală este mai mică decât viteza longitudinală (de-a lungul axei 

X) ea afectează dramatic soluŃia dacă nu se ia în consideraŃie când construim geometria 

curgerii. 

 Vom fixa originea sistemului de coordonate în colŃul stâng, jos al dreptunghiului care 

defineşte câmpul de curgere. Coordonatele colŃurile sunt prezentate în figura de mai jos: 

 

Vom crea pentru început patru puncte adiacente corespunzătoare celor patru colŃuri pentru ca 

apoi să creăm laturile dreptunghiului. După aceasta vom crea faŃa care cuprinde suprafaŃa 

dreptunghiului. 

 

Crearea unui folder de lucru 

CreaŃi un folder numit „placa”. Vom folosi acest folder ca fiind folderul de lucru în care se 

vom păstra toate fişierele. 

 

Pornirea GAMBIT-ului 

Se iniŃializează prompterul de comenzi 

Start > Run 

(0,0) 

y 

x 

(L,L) (0,L) 

(L,0) 
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Pentru Window NT/2000/XP: Se scrie cmd apoi se apasă OK 

 

 

După aceasta, intraŃi în folderul de lucru. De exemplu, dacă folderul creat, numit fluent pe 

partiŃia S: în Windows, executaŃi cd S:\fluent  

 

 

InterfaŃa GAMBIT arată astfel: 

- Bara meniului principal: 

 

 

- Meniul instrumentelor 



Laborator 5. ConvecŃie forŃată de-a lungul unei plăci 

 5 

 

Vom folosi acest meniu mai mult sau mai puŃin de-a lungul creării geometriilor. Se poate 

observa că fiecare meniu principal are sub-meniuri. 

 

- Meniul de control  

 

Meniul de control are opŃiuni precum „Fit to Screen”  şi „Undo”  care sunt foarte 

des utilizate în timpul creării geometriei precum şi a meshurilor. 

 

- Fereastra de lucru: 

 

Aceasta este fereastra unde se pot observa grafic toate operaŃiile pe care le executăm. 
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- Panoul de descriere 

 

Panoul de descriere conŃine descrierile butoanelor sau obiectelor peste care mişcăm cursorul 

mouseului. Mişcând mouseul peste butoate, putem observa aceste descrieri. 

 

- Fereastra de transcriere a comenzilor 

 

Aceasta este fereastra în care se scriu comenzile în Gambit şi în care se pot şterge/corecta. 

Dacă nu suntem siguri ca am apăsat butonul corect sau am greşit comanda, aici se poate 

monitoriza. Se poate mări fereastra prin apăsarea săgeŃii din partea de sus, dreapta iar pentru 

a reveni la dimensiunile iniŃiale, se apasă din nou. 

 

Selectarea Solverului 

Main Menu > Solver > Fluent 5/6 

 

Se verifică apoi dacă s-a activat, în fereastra de transcriere a comenzilor. 
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ConstrucŃia punctelor (vertexurilor)  

Se construiesc din meniul instrumentelor urmând următorii paşi: 

Operation Toolpad > Geometry Command Button  > Vertex Command Button 

 > Create Vertex  

 

Următorul pas este introducerea coordonatelor. Vom începe prin crearea unui vertex în colŃul 

stânga jos a dreptunghiului: 

În dreptul lui x: vom introduce valoarea 0. În dreptul lui y: de asemenea 0 iar la z: tot 

valoarea 0 (din cauză că avem o problemă bidimensională). Apoi se face clic pe „Apply”. 

Aceste valori au creat vertexul care are coordonatele (0,0,0). În figura de mai jos se observă 

grafic aceste valori: 

 

În fereastra de transcriere a comenzilor, Gambit-ul ne afişează comanda de creare a 

vertexului „Created vertex: vertex.1”. Vertexurile sunt numerotate consecutiv: vertex.1, 

vertex.2 etc.; în ordinea în care au fost create. 

 

Repetăm apoi acest proces pentru a crea celelalte trei vertexuri: 

Vertexul 2: (1,0,0) 

Vertexul 3: (1,1,0) 

Vertexul 4: (0,1,0) 

 

Apoi, pentru a putea încadra toate puncte în ecran, vom folosi comanda „Fit to window”. 
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Operation Toolpad > Global Control > Fit to Window Button  

 

Acum putem observa pe ecran toate cele patru puncte. 

 

 

ConstrucŃia laturilor 

În continuare vom conecta perechi apropiate de vertexuri pentru a crea laturile:  

Operation Toolpad > Geometry Command Button  > Edge Command Button 

 > Create Edge  

 

Pentru selectarea unui obiect în Gambit, se Ńine buton SHIFT de la tastatură şi apoi se 

selectează. Se pot face astfel selecta mai multe obiecte. În cazul nostru, vom selecta, pe rând, 

vertexurile. Pe măsură ce selectăm vertexurile, pe ecran ele vor apărea de culoare roşie (pot 

apărea şi de altă culoare, în funcŃie de setările culorilor – standard este roşie). Făcând click pe 

săgeata în sus din meniu, o mică fereastră se va deschide. 
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În această mini-fereastră vom observa vertexurile selectate. Ele pot fi mutate din stânga, unde 

sunt cele disponibile (Available) spre dreapta, unde sunt cele selectate (Picked) şi invers. 

Procesul de mutare se poate face simplu cu ajutorul săgeŃilor (---> şi <---). 

 

După ce au fost selectate vertexurile corecte, se închide mini-fereastra făcând click pe 

butonul Close apoi Apply din meniul de creare a laturilor. 

Pe ecran va apărea următoarea imagine: 

 

Se repetă aceiaşi paşi pentru crearea celorlalte laturi. 
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ConstrucŃia feŃelor 

Operation Toolpad > Geometry Command Button  > Face Command Button  

> Form Face  

Pentru a construi o faŃă înscrisă de patru laturi trebuie să selectăm cele patru laturi care 

formează suprafaŃa. Aceasta se poate face tot cu ajutorul tastei SHIFT, selectând pe rând 

fiecare latură (putem observa că liniile selectate apar de culoare roşie). După ce s-au selectat 

cele patru laturi, se ia mâna de pe tastă. 

Sau, mai simplu, se face clic pe săgeata în sus care deschide o alta mini-fereastră în care 

avem de această dată laturile. 

 

Iar mini-fereastra arată ca în figura de mai jos. 

 

Se trec apoi toate din stânga în dreapta prin simplu clic pe All����. Se închide apoi mini-

fereastra făcând clic pe Close apoi Apply. 

Avem: 
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PASUL 2: GEOMETRIA MESHURILOR ÎN GAMBIT 

 

Vom mesha o faŃă a dreptunghiului cu 30 de diviziuni în direcŃia longitudinală şi 100 în 

diviziuni pe direcŃia normală pe placă. Pentru început vom mesha cele patru laturi apoi faŃa. 

SpaŃiul dintre grile este specificat de către meshul feŃei. 

 

Mesharea laturilor 

Operation Toolpad > Mesh Command Button  > Edge Command Button  > 

Mesh Edges  

Este de dorit o densitate mai mare a meshurile în zona adiacentă plăcii deoarece avem 

condiŃii la limită pentru turbulenŃă pe un strat foarte subŃire în comparaŃie cu restul geometriei 

de reprezentare a curgerii. 

Din nou selectăm cu ajutorul tastei SHIFT sau din meniu laturile verticale. Dacă în fereastra 

grafică nu se observă bine aceste linii, putem mări Ńinând apăsată tasta CTRL apoi click pe 

zona pe care vrem să o mărim. Dacă s-a mărit prea mult, se poate reveni folosind „Fit to 

Window”. 

După ce am selectat una dintre laturile verticale, o vom diviza folosind „Interval Count” din 

butonul pe care scrie „Interval Size” din cadrul meniului de meshare a laturilor, dând 

valoarea 1,08 la Ratio. Apoi, în stânga se va trece numărul de diviziuni (în cazul nostru 100). 

De altfel, ne vom asigura şi că săgeata care indică direcŃia de meshare va fi în sus. În cazul în 

care nu este aşa vom da din meniu Reverse sau facem clic pe rotiŃa mouseului în timp ce 

Ńinem apăsată tasta Shift.  

 

Apoi se face clic pe Apply.  

Se selectează apoi cealaltă latură şi se urmează aceiaşi paşi de meshare. 

Avem o imagine ca în figura de mai jos: 
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Meshăm apoi laturile orizontale împărŃindu-le în 30 de unităŃi. Folosim aceiaşi paşi ca şi 

pentru meşharea feŃelor verticale dar de această dată vom avea la Ratio valoarea 1 iar la 

Interval Count valoarea 30. Avem: 

 

 

După ce am meshuit laturile putem crea meshuirea bidimensională a feŃei. 
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Mesharea feŃei 

Operation Toolpad > Mesh Command Button  > Face Command Button  > 

Mesh Face  

Se selectează apoi faŃa, cu ajutorul săgeŃii sau tastei SHIFT după care se face clic pe Apply 
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PASUL 3: SPECIFICAREA TIPURILOR DE LIMITĂ 

 

Definirea tipurilor de limită 

După cum se observă şi în figura de mai sus, vom definit tipurile de limite. Astfel, latura din 

stânga va fi intrarea în conductă, latura din dreapta ieşirea, cea de sus o definim ca fiind 

perete iar cea de jos ca axa. 

Operation Toopad > Zones Command Button  > Specify Boundary Types 

Command Button  

Aceasta va deschide meniul de specificare a tipurilor de limită. Prima dată vom specifică că 

latura din dreapta este intrarea. La „Entity:” vom face clic pe Edges pentru ca Gambitul să 

ştie că vrem să selectăm o latură. 

 

Vom selecta latura din stânga după care se face clic pe Apply. Apoi, la Name: vom pune 

inlet iar la Type: vom alege VELOCITY_INLET, urmat de Apply. 

 

 

 

 

 

Outlet 
(ieşire) 

Inlet 
(intrare) 

Symmetry 
(simetrie) 

Wall 
(placă) 
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Repetăm aceiaşi paşi şi pentru celelalte laturi, respectând tabelul: 

POZIłIA LATUREI NUMELE TIPUL 

Stânga intrare VELOCITY_INLET 

Dreapta iesire PRESSURE_OUTLET 

Sus simetrie SYMMETRY 

Jos placa WALL 

 

La final vom avea următoarele: 

 

 

Salvarea lucrului şi Exportul 

Main Menu > File > Save 

Main Menu > File > Export > Mesh 

Scriem pipe.msh la File Name:, apoi selectăm Export 2d Mesh deoarece este un mesh 

bidimensional. În final, clic Accept. 

 

Verificăm dacă placa.msh a fost creat în folderul de lucru. 
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PASUL 4: SETAREA PROBLEMEI ÎN FLUENT 

Se deschide fluentul: 

Start > All Programs > Fluent Inc Products > Fluent x.x.xx > Fluent x.x.xx 

 

 

Selectăm 2ddp din listă apoi Run 

„2ddp” este folosit atunci când folosim un solver bidimensional, de precizie dublă. În 

solverul de precizie dublă fiecare număr este reprezentat folosind 64 biŃi, în contrast cu 

solverul de precizie simplă care foloseşte 32 biŃi. Numărul mare de biŃi creşte precizia dar şi 

ordinul de mărime care poate fi reprezentat. Dezavantajul este că pentru astfel de solver 

avem nevoie de mai multă memorie. 

 

Importul grilei 

Main Menu > File > Read > Case… 

Cazul se deschide din folderul de lucru de unde se selectează placa.msh. Acest este fişierul 

care a fost creat de preprocesorul Gambit în pasul anterior. Fluentul expune meshurile exact 

cum sunt ele scrise în Gambit.  

 

Verificăm numărul de noduri, feŃe (de diferite tipuri) şi celule. În cazul nostru avem 500 

celule patrulatere. Acesta este numărul la care era normal să ne aşteptăm din moment ce 
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aveam 30 diviziuni în direcŃia radială şi 100 de diviziuni în direcŃia axială atunci când am 

construit grila, deci numărul total de celule este 30 · 100 = 3000. 

De altfel, dacă privim la zone, avem inlet, wall, outlet  şi centerline. 

 

Verificarea şi afişarea grilei 

Pentru început se verifică grila pentru a fi siguri că nu sunt erori.  

a ) Verificarea grilei se face din 

Main Menu > Grid > Check  

Orice eroare întâlnită va fi reportată imediat. Verificăm apoi ieşirea pentru a fi siguri că nici 

acolo nu avem erori. Apoi se face verificarea dimensiunii grilei: 

Main Menu > Grid > Info > Size 

Aceasta arată ca în figura de mai jos: 

  

b) Afişarea grilei se face din: 

Main Menu > Display > Grid 

Trebuie să ne asigurăm că toate suprafeŃele (Surfaces) sunt selectate. Apoi facem clic pe 

Display. O nouă fereastră în care vom observa grila se va deschide. Se va închide apoi făcând 

click pe Close. 

OperaŃiile disponibile în fereastra de grid sunt: 

- TranslaŃia: Gridul poate fi mutat în orice direcŃie, Ńinând apăsat clic stanga şi 

mişcând mouseul; 

- Mărirea: Aceasta se poate face Ńinând apăsată rotiŃa mouseului după care se mişcă 

din stânga spre dreapta. 

- Micşorarea: Aceasta se poate face Ńinând apăsată rotiŃa mouseului după care se mişcă 

din dreapta spre stânga. 

 

Mărirea grilei arată ca în figura de mai jos: 
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Putem să vizualizăm şi anumite părŃi ale grilei alegând din lista de suprafeŃe. Se face clic din 

nou pe Display şi apoi se vizualizează părŃile selectate. De exemplu: wall, outlet şi centerline. 

 

 

În cazul în care avem mai multe limite, putem să le selectăm sau să le deselectăm pe toaate 

folosind butoanele  de lângă Surfaces. 

 

Difinirea proprietăŃilor solverului 

Main Menu > Define > Models > Solver 

Vom alege Axisymmetric din lista de sub Space. Vom folosi setările prestabilite ale 

solverului segregat, formulare implicită, curgere staŃionară şi viteză absolută. 
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Main Menu > Define > Models > Viscous 

La Model vom selecta modelul cu care ne-am obişnuit deja şi anume modelul de turbulenŃă 

k-epsilon. Vom folosi în cadrul acestui model, tipul Realizable (realizabil). Modelul 

Realizable k-epsilon are o precizie mai ridicată pentru stratul limită de curgere decât 

modelul Standard. În căsuŃa Near-Wall Treatment (tratament adicent peretelui) selectăm 

Enhanced Wall Treatment (tratament intensificat al peretelui) care are o rezoluŃie mai mare 

a stratului limită în modelul ales. Sunt trei regiuni în stratul limită: 

1. Laminar sublayer (substrat laminar) (y+<5) 

2. Buffer region (regiunea tranzitivă) ( 5 < y+ < 30) 

3. Turbulet region (regiune turbulentă) (y+ > 30) 

y+ este o distanŃă adimensională dependentă de mesh care cuantifică gradul în care stratul 

adiacent peretelui este rezolvat. OpŃiunea de tratament intensificat pe lângă perete (Enhanced 

Wall Treatment) serveşte o rezolvare mai precisă a stratului limită în cazul in care meshul 

este suficient de bun pentru rezolvarea regiunii turbulente (y+ > 30). Tot această opŃiune 

măreşte precizia meshului care poate rezolvat doar în zona de tranziŃie (5 < y+ < 30). Oricum, 

soluŃia cu valoarea y+ în zona de tranziŃie sunt, în general, mai puŃin precisă decât dacă 

soluŃia este rezolvată în una dintre celelalte două regiuni. A se consulta şi fişa de 

documentare, capitolul 10.9, Grid Consideration for Turbulent Flow Simulation 

(ConsideraŃii ale ochiurilor de reŃea pentru simularea curgerii turbulente) pentru mai multe 

detalii. 

 Pentru meshul nostru, Fluentul va rezolva substratul laminar, deci tratamentul de 

intensificare la pereŃi nu măreşte precizia soluŃiei cu meshul nostru. Dar diferenŃa va fi 

sesizabilă în cadrul Pasului 7 când vom folosi mesh mai fin. Grosimea stratului limită este 
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semnificativ mai mică decât lungimea câmpului de curgere. Rezolvarea soluŃiei în substratul 

laminar este dificilă, în special în tipul de curgere în care numărul lui Reynolds este mare. 

Rezolvarea zonei turbulente este de cele mai multe ori singura opŃiune rezonabilă. Deci, este 

bine să folosim întotdeauna Enhanced Wall Treatment atunci când lucrăm cu stratul limită. 

Chiar daca nu este necesar în meshul nostru, va fi indispensabil pentru meshul mai puŃin fin. 

 Selectăm Thermal Effects (efect termic) mai jos pentru a include termenii termici în 

ecuaŃia tratamentului intensificat de la pereŃi. 

 Valoarile de sub Model Constanst (constantele modelului) sunt cele corespunzătoare 

ecuaŃiei de turbulenŃă k-epsilon. Aceste valori sunt valabile pentru o multe cazuri de curgeri 

adiacente pereŃilor. Nu vom modifica nimic aici.  

 

Main Menu > Define > Models > Energy 

Deoarece avem transfer de căldură, vom activa ecuaŃia energiei. 

 

Facem apoi clic pe Ok. 

 

Definirea proprietăŃilor materialelor 

Main Menu > Define > Materials… 
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Vom modifica: 

 Densitatea > luăm modelul unui gaz ideal (ideal-gas); 

 Căldură specifică > valoarea constantă 1006,43 

 Conductivitate termică > valoarea constantă 0,00094505 

 Viscozitate > valoarea constantă 6,667e-07 

Apoi facem clic pe Change/Create.  

 

Definirea condiŃiilor de operare 

Main Menu > Define > Operating Conditions 

Pentru toate curgerile, Fluentul foloseşte măsura presiunii interioare. De fiecare dată 

când este nevoie de presiunea absolută, ea este generată prin adăugarea presiunii de operare la 

presiunea măsurată. Vom folosi valoarea predefinită de 1 atm. (101,325 Pa) ca presiune de 

operare. 

 

 

Definirea condiŃiilor la limită 

Vom stabili în continuare valoarea vitezei la intrare şi a presiunii la ieşire. 

Main Menu > Define > Boundary Conditions… 

Observăm în partea stângă şase tipuri de limită dintre care patru sunt definite de noi 

iar două sunt alocate automat (default-interior şi fluid) utilizate pentru definirea interiorului 

câmpului de curgere. Nu vom schimba nimic la aceste două zone. 
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Selectăm intrare. Observăm că Fluentul recunoaşte tipul de limită pe care l-am 

selectat din Gambit şi anume velocity_inlet.  Dacă este necesar putem schimba tipul de limită 

stabilit în Gambit direct din Fluent. În continuare selectăm velocity_inlet apoi facem clic pe 

Set... pentru a introduce parametrii. 

La Velocity Magnitude vom introduce valoarea 1. La Turbulence Specification 

Method (Metoda de specificare a turbulenŃei) vom selecta Intensity and Viscosity Ratio 

(Intensitatea şi rata viscozităŃii) iar mai jos, vom avea în ambele căsuŃe valoarea 1. Atât la 

Turbulence Intensity (Intensitatea turbulenŃei) cât şi la Turbulent Viscosity Ratio (Rata 

viscozităŃii turbulenŃei). Apoi, în bara de sus avem Thermal. Vom specifica aici temperatura 

de intrare şi anume 353 K. Facem apoi clic pe Ok. 

 

 În continuare selectăm iesire. Observăm tipul de limită şi anume pressure-outlet. Facem 

clic pe Set...  Valoarea predefinită a presiunii (Gauge Pressure) este 0. Presiunea absolută la 

ieşire este de 1atm. Deoarece avem stabilită presiunea de operare (din Operating 

Conditions) avem: presiunea la ieşire (Gauge Pressure) = presiunea absolută – presiunea de 

operare = 0. Lăsăm totul prestabilit şi dăm clic pe Cancel.  
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În final selectăm placa şi ne asigurăm că tipul acestei limite este tot wall (perete). Deoarece 

trebuie să încălzit o placă încălzită izoterm trebuie să introducem temperatura. Mergem la 

Thermal iar în lista de la Thermal Conditions (condiŃii termice) selectăm Temperature iar 

în dreapta vom introduce, la Temperature, valoarea 413. Facem clic apoi pe Ok pentru 

validare. 

 

 

Închidem fereastra condiŃiilor la limită. 
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PASUL 5: REZOLVAREA 

Vom folosi o schemă de discretizare de ordinul doi. 

Main Menu > Solve > Controls > Solution… 

Schimbăm valoarea momentul din ordinul I în ordinul II (Second Order Upwind) 

 

Schimbăm la Density, Momentum, Turbulent Kinetic Energy, Turbulent Dissipation 

Rate şi Energy tipul de discretizare, din First Order Upwind (discretizare de gradul I) în 

Second Order Upwind (discretizare de gradul II). Lăsăm celălalte cu valorile prestabilite. 

 

Se face prima presupunere 

Se iniŃializează câmpul curgerii cu valorile de la intrare: 

Main Menu > Solve > Initialize… 

În meniul Solution Initialization la Compute From vom alege intrare. Viteza de-a 

lungul axei X pentru toate celulele va fi setată la 1 m/s iar cea de-a lungul axei Y va fi 0 m/s. 

Aceste valori au fost luate de la condiŃiile limită la intrare. 
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Facem clic pe Init pentru a iniŃializa, apoi Apply şi, în final, Close. 

 

Setarea crierului ce convergenŃă 

Fluentul face raportul la reziduul pentru fiecare ecuaŃie ce urmează a fi rezolvată. 

Reziduul este măsura la cât de mult satisface soluŃia curentă forma discretizantă a fiecărei 

ecuaŃii ce guvernează. Vom itera soluŃia până când reziduul fiecărei ecuaŃii scade sub 1 · 10-6. 

Main Menu > Solve > Monitors > Residual… 

Schimbăm reziduul pentru continuity, x-velocity, y-velocity , energy, k şi epsilon, 

toate cu valoarea 1e-6. După aceasta, pentru vizualizare, se face clic pe Plot. Acesta va face 

graficul reziduurilor în fereastra grafică după cum sunt ele calculate. Print face ca pe ecranul 

principal al programului să apară calculele făcute pas-cu-pas de către program (a nu se face 

confuzia cu Print folosit pentru imprimare). 
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Dacă vă apar erori de tipul “Error: FLUENT received a fatal signal 

(SEGMENTATION VIOLATION)” sau „Error: floating point error: divide by zero” 

înseamnă că placa video este configurată pentru funcŃionarea calculatorului cu viteză şi nu 

pentru performanŃă. ConsultaŃi un expert pentru soluŃionarea unei astfel de probleme. 

 

Am terminat specificaŃiile problemei. Salvăm totul: 

Main Menu > File > Write > Case… 

Salvăm cu numele placa.cas pentru fişierele de tip case. Verificăm apoi dacă s-a salvat în 

folderul de lucru. Dacă închidem Fluent-ul acum, putem continua cu tot ceea ce am stabilit 

până acum. 

 

Iterăm până la convergenŃă 

Vom porni calcularea făcând 10000 de iteraŃii: 

Main Menu > Solve > Iterate 

În fereastra de iteraŃii (Iterate Window) schimbăm numărul de iteraŃii de la 1 la 

10000 apoi facem click pe Iterate. 

Reziduurile pentru fiecare iteraŃie sunt afişate şi listate în fereastra de grafice după 

cum sunt ele calculate. 

 

Reziduurile ajung la criteriul de convergenŃă specificat (1 · 10-6) la 46 de iteraŃii. 
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Se salvează soluŃia ca un fişier dată: 

Main Menu > File > Write > Data… 

Introducem la nume placa.dat. Din nou, se verifică dacă fişierul a fost salvat în folderul de 

lucru. Din acest moment se pot determina soluŃiile de fiecare dată folosind acest fişier. 
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PASUL 6: ANALIZA REZULTATELOR 

 

y+ 

Curgerile turbulente sunt afectate semnificativ de prezenŃa pereŃilor. Validitatea modelului de 

turbulenŃă k-epsilon este independentă de ochiurile de reŃea îndepărtat pereŃilor dar are 

nevoie de verificare pentru a ne asigura că este valid adiacent pereŃilor. Modelul adiacent 

peretelui este dependent de rezoluŃia ochiurilor de reŃea care este atribuit unităŃii y+, după 

cum am discutat şi în Pasul 4. 

Pentru început este nevoie să stabilim valorile de referinŃă necesare calculării y+. 

Main Menu > Report > Reference Values  

Selectăm intrare în căsuŃa de la Compute From (calculează din) pentru a da indicaŃii 

programului de stabilire a valorilor de referinŃă de la intrare. Verificăm dacă avem la 

Velocity valoarea 1, la Temperature 353K şi Viscosity 6,667e-07 în căsuŃele de mai jos. La 

zona de referinŃă (Reference Zone) vom selecta fluid. 

 

 

Prin folosirea a folosi următoarea medotă, trebuie să afişăm valorile y+ în celulele adiacente 

peretelui pentru compararea cu recomandările menŃionate mai sus. 

 

Vom afişa valoarea y+. 

Main Menu > Plot > XY Plot… 
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Ne asigurăm că în mini-fereastră, la Options avem selectat Position on X Axis, şi că 

X este setat la 1 iar Y este 0 la Plot Direction (direcŃia de afişare). Asta înseamnă că Fluentul 

va afişa valorile lui x pe abscisa graficului. 

La Y Axis Function, alegem Turbulence iar mai jos vom alege Wall Yplus. La 

Surfaces selectăm placa. 

 

 

Avem: 

 

După cum putem observa, valoarea y+ a peretelui este vizibilă între 1 şi 1,4 (ignorând 

anomalia de la intrare). Deoarece aceste valori sunt mai mici decât 5, rezoluŃia meshului de 

lângă perete este în substratul laminar, care este cea mai precisă regiune cu care putem 

rezolva stratul limită. 
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Salvăm graficul 

 În mini-fereastra Solution XY Plot Window, selectăm Write to File şi observăm că 

butonul Plot s-a transformat în Write. Facem clic pe Write..., introducem numele 

yplusplaca.xy la numele fişierului apoi facem clic pe Ok. Verificăm dacă acest fişier se află 

în folderul de lucru. 

 

Afişăm profilul de viteză la distanŃa x = 1 m 

Main Menu > Plot > XY Plot... 

La Options, deselectăm Position on X Axis şi selectăm Position on Y Axis. La Plot 

Direction, introducem 0 în dreptul valorii X şi 1 în dreptul valorii Y. Aceasta comandă 

Fluentul să afişeze un profil vertical. 

La X Axis Function selectăm Velocity şi apoi în căsuŃa de dedesubt selectăm X Velocity. În 

final, selectăm la Surfaces limita iesire deoarece afişăm profilul la ieşire. Deselectăm placă.  

 

Facem clic apoi pe Axes... în minifereastra de afişare a profilului XY. Selectăm X în 

căsuŃa Axis. Selectăm Major Rules pentru a activa liniile de pe grafic. Facem apoi clic pe  

Apply. Apoi selectăm Y şi Major Rules şi deselectăm Auto Range. În căsuŃa Range 

introducem valoarea 0.1 la Maximum deci vom observa profilul de viteză mai aproape.  



Laborator 5. ConvecŃie forŃată de-a lungul unei plăci 

 32 

 

Facem clic pe Apply apoi Close.  

 

Deselectăm Write to File apoi facem clic pe Plot. 

 

Observăm aici că viteza de-a lungul axei X ajunge la 1 m/s la o distanŃă de aproximativ y = 

0,02 m. Aceasta arată grosimea relativă a stratului limită comparativ cu lungimea plăcii. 

Remarcăm şi faptul că profilul de viteză este mai mare de 1 m/s deasupra strutului limită. 

Ştim că acest lucru nu se poate întâmpla într-o curgere reală ci mai degrabă este rezultatul 

condiŃiei la limită pe care am ales-o pentru modelul nostru. Oricum, nici o curgere nu are voie 

să iasă din strat. 

Într-o curgere exterioară reală nu este un astfel de strat la suprafaŃa şi fluidul poate trece liber. 

Când considerăm profilul vitezelor de intrare şi ieşire în termeni de conservare a masei, 

profilul uniform de viteză de 1m/s la x = 0 are mai multă masă intrată în câmpul de curgere 

decât profilul neuniform de viteză la x = 1 în care viteza este mică la nivelul plăcii. În plus, 
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fluidul se dilată în zona de lângă placă teoarece temperatura creşte, crescând astfel şi viteza 

verticală a fluidului. Aceşti factori au nevoie ca o cantitate de masă să fie eliberată prin partea 

de sus a câmpului nostru de curgere pentru a satisface conservarea masei. 

 

Introducând o limită de tipul pressure_outlet în partea de sus ar rezulta o curgere reală cu 

precizie mai ridicată. Din păcate aceasta nu poate fi folosită în câmpul nostru de curgere fără 

a provoca probleme de convergenŃă deci alegerea făcută (definirea limitei ca simetrie) este 

una bună. Deoarece nu dorim ca această curgere să depăşească stratul limită de sus, observăm 

un profil de viteză la ieşire în care viteza este mai mre decât 1 deasupra stratului limită pentru 

a satisface legea conservării masei. Din fericire aceste neconcordanŃe rezultate din modelul 

ales nu au un efect semnificativ asupra coeficienŃilor de transfer termic al plăcii. 

 Selectăm Write to File şi salvăm datele sub denumire de profiliesire.xy.  

 

Afişăm numărul Nusselt funcŃie de numărul Reynolds. 

 Amintit faptul că numărul Nusselt este un coeficient de transfer de căldură non-

dimensional asociat conducŃiei şi convecŃiei. 

 Nux = 
hx · x

k   

Pentru a obŃine numărul lui Nusselt cu ajutorul programului Fluent, vom face afişarea 

fluxului total de căldură la suprafaŃă (Total Surface Heat Flux).  

Main Menu > Plot > XY Plot 

În căsuŃa Options, schimbăm din nou pe Position on X Axis. În căsuŃa Plot Direction 

introducem la X valoarea 1 şi 0 la Y. La Y Axis Function selectăm Wall Fluxes iar în căsuŃa 

de mai jos avem Total Surface Heat Flux. Selectăm placa la Surfaces. Înainte să afişăm ne 

asigurăm că avem selectat Auto Range pentru Y.  
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Selectăm din nou Write to file şi sciem sub denumirea de flux.xy. 

Deschidem flux.xy cu programul din pachetul Microsoft Office şi anume Microsoft Excel.  

 

Prima coloană corespunde lungimii de-a lungul axei x a plăcii iar a doua este fluxul total de 

căldură la suprafaŃă (q’’) corespunzătoare fiecărei lungimi. Avem nevoie acum să 

determinăm numărul Nusselt din aceste valori la fiecare locaŃie pe axa X. Vom defini q’’ 

pozitiv ca fiind transferul termic din fluid. Folosim următoarele expresii pentru a transforma 

q’’ în număr Nusselt folosind Excel. 

 q’’x = hx·(Tfluid(x, y = 0) – Tplacă) 

 Nux = 
hx · x

h  = (
q``x

Tplate - T∞
 )(

x
k ) = (

q''x
60 )(

x
 9.4505e - 4W/mK ) 
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Numărul lui Reynolds trebuie definit la fiecare punct X. 

Acum vom afişa un grafic Re vs Nu în Excel. 

 

ComparaŃia rezultatelor date de corelaŃii şi experiment 

 Validăm rezultatul obŃinut în Fluent prin compararea rezultatelor corelat şi rezultatele 

experimentale. CorelaŃiile pe care le vom utiliza derivă din relaŃia lui Reynolds: 

Nux = 0,0296(Rex
0,8)(Pr0,6)(

Tplate

T∞
)-0,4 

Toate proprietăŃile în această corelaŃie sunt evaluare la temperatura statică de 300K. CorelaŃia 

se compune din: 

1. Pr = 0,7 

2. 105 < Re < 107 

3. ProprietăŃile fluidului evaluate în condiŃii de curgere liberă; 

4. Strat limită compresibil turbulent; 

5. Placă; 

6. Factorul de frecare calculat din următoarea relaŃie (implicit în ecuaŃia lui Nu de 

mai sus şi nu este necesar să-l calculăm): 

Cf = 0,0296Rex
-0,2 

Adăugăm corelaŃia Reynold la numărul Nusselt în Excel. 

Seban şi Doughty au făcut un experiment asemănător dar ei au lansat următoarea expresie 

pentru numărul lui Nusselt: 

 Nux = 0,0236 (
ρ · u · x

 µ  )4/5 
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Experimentul lor a avut drept fluid aerul (Pr=0,7) şi numere diferite ale numărului lui 

Reynols într-un câmp de 1e5 < Re < 4e6. Adăugăm şi această relaŃia pentru numărul lui 

Reynolds în Excel. 

Acum vom afişa un grafic Re vs Nu în Fluent şi comparăm cu CorelaŃia Reynolds şi 

experimentul lui Seban. 

 

După cum putem observa, este o mică variaŃie între cele trei rezultate. Cea mai mare eroare 

(în %) între rezultatele obŃinute în Fluent şi corelaŃiile Reynolds este doar de 7,5%. În cazul 

curgerii turbulente, cum este cazul nostru, rezultate similare între cele două sunt mai greu de 

obŃinut decât cele în cazul curgerii laminare deoarece un model turbulent trebuie să fie 

utilizat în Fluent, care nu rezolvă ecuaŃiile Navier-Stokes cu exactitate. Eroarea 

experimentală (în experimentele din care rezultă corelaŃiile) ia în consideraŃie o parte din 

eroarea de 7,5%. Fiecare din modelele de turbulenŃă pe care Fluentul le oferă dau rezultate 

similare cu acestea dar cu toate astea modelul k-epsilon este cel mai bun model. 
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PASUL 7: CURAłAREA MESHURILOR 

Vom modifica meshul din Gambit. Vom modifica meshul cu următoarele dimensiuni: 30x50 

şi 30x150. 

Vom face modificarea pentru meshul de dimensiune 30x50(stânga) şi 30x150 (dreapta). Vom 

selecta laturile orizontale şi le vom schimba ratele, odată cu 1,095 şi numărul de intervale 50 

pentru meshul de dimensiune 30x50 şi 1,065 iar numărul de intervale de 150 pentru meshul 

30x150. 

                               

Vom deschide meshurile cu Fluent din nou şi vom parcurge din nou paşii 2, 3, 4, 5 şi 6. 

Avem următorele grafice pentru valoarile de turbulenŃă y+:  

- pentru meshul 30x50 
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- pentru meshul 30x150 

 

Pentru fluxul de căldură avem: 

- pentru meshul 30x50: 

 

Observăm că meshul brut produce rezultate cu diferenŃe mari dar chiar şi aşa este unul 

rezonabil. O mică eroare numerică apare atunci când folosim meshuri mai rare (30x50). 

După cum ne aşteptam, pentru rezolvarea stratului limită a substratului laminar, pe care l-

am avut cu meshul original dă o acurateŃe mai mare rezultatului decât rezolvând în zona 

turbulentă. Rezolvarea substratului laminar nu este întotdeauna o soluŃie foarte bună, în 

special atunci când avem numere Reynolds mari. Rezultatul generat pe un mesh 30x50 

arată că o soluŃie rezonabilă poate fi obŃinută fără a rezolva substratul laminar.  

- pentru meshul 30x150 
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Acest grafic ne arată că rezultatele nu s-au schimbat prin rafinarea meshurilor dar 

putem concluziona că meshul folosit anterior (30x100) este suficient de bun. Este foarte 

important să se facă verificarea dacă soluŃia nu se schimbă prin rafinarea meshurilor în 

direcŃia curgerii. În acest caz, meshul în direcŃia curgerii este deja foarte bun pentru a 

elimina eroarea numerică dependentă de mesh. 


